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License Agreement 

 

 
SOFTWARE PRODUCT:  CXSpectra© 
Copyright 1995-2013 (C) MaintTech SWEDEN - All Rights Reserved 
 
 
IMPORTANT! READ CAREFULLY: This MaintTech SOFTWARE LICENSE AGREEMENT (SLA) is a 

legal agreement between you (either an individual or a single entity) and MaintTech SWEDEN for 

the CXSpectra© SOFTWARE PRODUCT identified above, which includes computer software and 
associated media and printed materials (if any), and may include online or electronic 
documentation. By installing, copying, transferring or other using the SOFTWARE PRODUCT, you 
agree to be bound by the terms of this SLA. If you do not agree to the terms of this Agreement, 
you are not authorized to use, copy, or transfer the SOFTWARE PRODUCT. 
 

Grant of License 
Evaluation and registration 
The SOFTWARE PRODUCT is not free software.  
You are specifically prohibited from charging, or requesting donations, for any such copies, 
however made; and from distributing the software and/or documentation with other products 
(commercial or otherwise) without prior MaintTech SWEDEN written permission.  
If, after the evaluation period, you decide that the PRODUCT does not fit your requirements, you 

have to uninstall and destroy all Products’ copies.  
 
Standard License 

Workstation / file server 
Except as set forth below, you may use the SOFTWARE PRODUCT on any single computer. You may 
also install a copy for your exclusive use on either a home or portable computer. 

If you have acquired the PRODUCT in a MaintTech Software License Pack, you may make the 
number of additional copies of the PRODUCT equal to the number of purchased licenses and you 
may use each copy in the manner specified above. You are also entitled to make a corresponding 
number of secondary copies for either home or portable computer use as specified above. 
 
Educational License 
You may use the PRODUCTS acquired in special conditions (usually lower price) as Educational 

License ONLY if you are an educational institute and ONLY on educational purpose computers. You 
are not allowed to use these Licenses for administrative, accounting or other such activities. 
 
Open License 
You may use the PRODUCT acquired as Open License on ALL your computers, Internet domains, 

branches that belong to your company, but only in one country. There is NO RESTRICTION to use 
the PRODUCT inside the company (including local branches). 

 
Update 
All licensees may download and use the latest version of the PRODUCT and the latest Service Pack, 
starting with the first installation, but not longer than 14 months from the PRODUCT acquisition. 
 
Other rights and limitations 

Storage 
You may store or install a copy of the PRODUCT on a storage device, such as a network server, 
used only to install or run the Software over an internal network; however, you must acquire and 
dedicate a license for each individual who will use the PRODUCT. One License for the PRODUCT 
may not be shared or used concurrently on different computers. If the Software is installed on a 
network server or other system that physically allows shared access to the Software, you agree to 
provide technical or procedural methods to prevent use of the Software by individuals not 

specifically licensed to use the Software pursuant to this Agreement. 
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Transfer 
You may transfer the Software and Documentation to a single recipient on a permanent basis 
provided you retain no copies of the Software or Documentation (including backup or archival 
copies) and the recipient agrees to the terms and conditions of this Agreement. If the Software is 

an upgrade, any transfer must include all prior versions of the Software and Documentation. 
 
Reverse Engineering 
You may not modify, translate, reverse engineer, recompile, disassemble (except to the extent 
applicable laws specifically prohibit such restrictions) or create derivative works based on the 
Software, or any portion thereof. 
 

Copying 
You may not copy the Software or Documentation except as specifically provided by this 
Agreement. 
 

Rental 
You may not rent or lease the Software or Documentation. 

 
Proprietary Notices 
You may not remove any proprietary notices, labels or marks on the Software or Documentation. 
 
Use of MaintTech’s name 
You may not use MaintTech or MaintTech's suppliers' name, logos, or trademarks in any manner 
including, without limitation, in your advertising or marketing materials, except as is necessary to 

affix the appropriate copyright notices as required herein. 
 
Termination 
The License is in effect until terminated. The License will terminate automatically if you fail to 
comply with the limitations described herein. On termination, you must destroy all copies of the 
Software and Documentation. 

 

Diverse 
This Agreement represents the complete agreement concerning this license between the parties 
and supersedes all prior agreements and representations between them. This Agreement may be 
amended only in writing executed by both parties. THE ACCEPTANCE OF ANY PURCHASE ORDER 
PLACED BY YOU IS EXPRESSLY MADE CONDITIONAL ON YOUR ASSENT TO THE TERMS SET FORTH 
HEREIN, AND NOT THOSE CONTAINED IN YOUR PURCHASE ORDER. If any provision of this 

Agreement is held to be unenforceable for any reason, such provision shall be reformed only to the 
extent necessary to make it enforceable and the remainder of this Agreement shall nonetheless 
remain in full force and effect 
 
Limited warranty 
Media 
MaintTech Sweden warrants that the media containing the Software, if provided by MaintTech, is 

free from defects in material and workmanship and will so remain for 30 (thirty) days from the 
date you acquired the product. MaintTech's sole liability, and your sole remedy, for any breach of 

this warranty shall be to replace your defective media. Replaced media shall be covered by this 
limited warranty for the period remaining under the warranty that covered the original media, or if 
longer, for thirty (30) days after the date of shipment to you of the replaced media. 
 
Software Product 

This software and the accompanying files are provided "as is" and without warranties as to 
performance or merchantability or any other warranties whether expressed or implied. Because of 
the various hardware and software environments into which MaintTech Sweden may be put, no 
warranty of fitness for a particular purpose is offered.  
 
Good data processing procedure dictates that any program be thoroughly tested with non-critical 

data before relying on it. The user must assume the entire risk of using the program. 
 
The rest of the warranties do NOT refer to the evaluation period. 
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MaintTech Sweden warrants that (a) the Software will perform substantially in accordance to the 

accompanying written materials for a period of ninety (90) days from the date of receipt, and (b) 
any Support Services provided by MaintTech Sweden shall be substantially as described in 

applicable written materials provided to you by MaintTech, and MaintTech support engineers will 
make commercially reasonable efforts to solve any problem issues. To the extent allowed by 
applicable law, implied warranties on the Software, if any, are limited to 90 (ninety) days. 
MaintTech's sole liability, and your sole remedy, for any breach of this warranty shall be, in 
MaintTech's sole discretion: (i) to replace your defective Software; or (ii) if the above remedy is 
impracticable, to refund the License fee you paid for the Software. Replaced Software and 
Documentation, if any, shall be covered by this limited warranty for the period remaining under the 

warranty that covered the original Software, or if longer, for thirty (30) days after the date of 
shipment to you of the replaced Software. 
Only if you inform MaintTech Sweden of your problem with the Software during the applicable 
warranty period and provide evidence of the date you acquired the Software will MaintTech Sweden 
be obligated to honour this warranty. MaintTech Sweden will use reasonable commercial efforts to 
replace or refund pursuant to the foregoing warranty within thirty (30) days of being so notified. 

THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY MaintTech. MaintTech 
Sweden MAKES NO OTHER WARRANTY, REPRESENTATION, OR CONDITION, EXPRESS OR IMPLIED, 
AND EXPRESSLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, AND NO INFRINGEMENT OF THIRD PARTY RIGHTS. THE DURATION OF 
IMPLIED WARRANTIES OR CONDITIONS, INCLUDING WITHOUT LIMITATION, WARRANTIES OR 
CONDITIONS OF MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE, IS LIMITED 
TO THE ABOVE LIMITED WARRANTY PERIOD; SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS 

ON HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS, SO LIMITATIONS MAY NOT APPLY 
TO YOU. NEITHER MaintTech AGENT NOR ANY EMPLOYEE IS AUTHORIZED TO MAKE ANY 
MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARRANTY. If you make any 
modifications to the Software during the warranty period; if the media is subjected to accident, 
abuse, or improper use; or if you violate the terms of this Agreement, then this warranty shall 
immediately be terminated. This warranty shall not apply if the Software is used on or in 
conjunction with hardware or software other than the unmodified version of hardware and software 

with which the Software was designed to be used as described in the Documentation. 
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS 

THAT VARY FROM STATE TO STATE OR BY JURISDICTION. 
 
Limitation of liability 
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR OTHERWISE, 

SHALL MaintTech Sweden OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU OR ANY OTHER 
PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY 
CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK 
STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL 
DAMAGES OR LOSSES, OR FOR ANY DAMAGES IN EXCESS OF MaintTech's LIST PRICE FOR A 
LICENSE TO THE SOFTWARE AND DOCUMENTATION, EVEN IF MaintTech Sweden SHALL HAVE 
BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER 

PARTY. 
 
Copyright 
All intellectual rights in the Software and Documentation are property of MaintTech. By buying or 

using the software you are granted only a non-exclusive right to use a copy of the software. All 
intellectual rights in the Software remain property of MaintTech Sweden copyrights law and 
international treaties protect the PRODUCT. 
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1 Introduction 

 

This product has been developed to work on any properly configured version of the 

following Operating Systems: 

 

Windows XP (32-bit and 64-bit) 

Windows Server 2003 (32-bit and 64-bit) 

Windows Vista (32-bit and 64-bit) 

Windows 2008 (32-bit and 64-bit) 

Windows 7 (32-bit and 64-bit) 

Windows 8 (32-bit and 64-bit) 

Windows 2008 R2 

Windows Server 2012 

 

Due to the nature of the anti-piracy security technology built into this product, using 

illegal keys may lead to software failure or instability. 

 

Before running the setup file, make sure that all the other programs are closed. This 

includes anti-virus software and any other programs which are running. If you do not 

follow this procedure, it may interfere with the normal setup procedure. 

 

To start installing the software onto your computer, just make sure your CD-ROM was 

placed into the CD-ROM player. Because of its “Autorun” functionality, the installation 

program will start automatically. When this doesn't happen, go to “My Computer” and 

double click the CD-ROM icon. Find the AUTORUN folder. Next: double click on the 

installer (Autorun.exe file) and follow the instructions displayed on screen. 

 

 
 

Now, you are ready to install the application on your computer. 
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2 The installing procedure 

 

For a complete installation, you must follow the next steps: 

 

 Install the SystemChecker application. 

 Install CXSpectraTM and run it once. 

 Install the latest Service Pack for CXSpectraTM 

  Install the Drivers for HASP Protection Key. 

 Configure CXSpectraTM for Windows 7 and Windows 8 Operating Systems. 

2.1 Installing SystemChecker 

 

Sometimes, during CXSpectraTM installation, some of the additional files required by this 

applications are not installed. This happens when the user doesn’t have the full 

administrator privilege during the installation procedure, or from another unknown 

reason. In such a situation, you should also install in your computer the SystemChecker 

application. By doing this, the files required for CXSpectraTM will be installed or properly 

updated. The installed files are virus checked and are in accordance with the Microsoft 

recommendation. 

 

For more details, please read the following article: 

 

Description of the cumulative update rollup for the Visual Basic 6.0 Service Pack 6 

Runtime Extended Files on address: 

http://support.microsoft.com/kb/957924 

 

Click on: 

 

 
 

Follow the instructions displayed on screen. 

 

After clicking the SystemChecker label, the following warning message may occur: 

 

 
 

http://support.microsoft.com/kb/957924
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     Just click Yes to continue with the installation. 

 

 

Once the installation finished, just run the SystemChecker and look on the installed file 

status, to observe if they are all OK. If not, you may probably have a security issue and 

you should ask for your IT Administrator help. 

 

The SystemChecker window looks as follows: 

 

 
 

The file status appears on the right side. 

2.2 Installing CXSpectra™ 

 

 Click on: 

 

 
 

Follow the instructions displayed on screen. 

 

If you accept the default location, CXSpectraTM will be installed on C:\Program 

Files\CXSpectra directory. 

 

After clicking CXSpectra label, the window User Account Control may 

appear.  

 

Just press YES. 
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When the installation is finished, you must run for the first time your CXSpectraTM 

application. 

 

Now, you can also select the software language. 

 

You may use the icon placed onto your desktop. Because the application doesn’t find any 

HASP Protection Key, you may run the CXSpectraTM in Demo mode. Just access your 

application, and then close it. 

 

From now on, the Operating System will know the location where your CXSpectraTM has 

been installed. 

2.3 Installing the latest Service Pack 

 
The latest available Service Pack is always onto the CD-ROM. 

 

Click on: 

 

 
 

Follow the instructions displayed on screen. 

 

After clicking the Service Pack label, the window User Account Control 

may appear.  

 

Just press YES. 

 

2.4 Installing the HASP Drivers 

 
To run normally your CXSpectraTM application, you need a proper HASP 

Protection Key, attached in any USB free hub. The Protection key won’t be 

recognized by the Operating System, if the key drivers haven’t been 

installed first. 

 

Click on: 

 

 
 

Follow the instructions displayed onto the screen, to complete the installation. 

 

In a few seconds, the HASP Protection key will lit, indicating that the drivers were 

successfully installed. 

 

For further information about the HASP Protection Key Drivers, please read the 

readme.html file, existing into the HASP Drivers folder or visit: 

http://sentinelcustomer.safenet-inc.com/default.aspx 

 

Please note Sentinel HASP product is now referred to as Sentinel LDK. 

http://sentinelcustomer.safenet-inc.com/default.aspx
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When the HASP Drivers have been installed, you may run and use the CXSpectraTM. 

 

Before starting CXSpectraTM, you can check if the USB protection key drivers were 

properly installed, by running the external software: Start > Programs > CXSpectra > 

Test Protection Key. 

 

 
 

In Windows 8, all installed applications will appear as follows: 

 

 
 

Just click the icon to open the desired application. 

 

The Test Protection Key is simple software, used to detect any possible problem of the 

HASP Protection key. Make sure the protection key is inserted in any USB hub and press 

the Test Key button. If the protection key drivers are properly installed, the key type will 

be shown. Otherwise, an error message will be displayed on the screen. 

 

If a CXSpectraTM Key is found, the screen will appear as follows: 
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CXSpectraTM has associated three types of Protection Keys: 

- User Key (light green) 

- Demo Key (light blue) 

- GraphView Key (Black) 

 

The Demo Key is a trial key and cannot be used for commercial purposes. 

2.5 Updating the CXSpectra™ software 

 
 

The CXSpectraTM software is equipped with an automatic 

software update check.  

You can easily check if there is any free update available, by 

selecting: 

Help > Check for Updates now...  from the menu bar.  

An Internet connection is required for this. 

 

      

If a new update (Service Pack) is available, the downloading of the package will begin on 

your demand. Please, check regularly if a new Service Pack is available. The updating of 

the existing CXSpectraTM is free. 

 

NOTE: If you start CXSpectraTM and you are connected to the Internet and a new Service 

Pack is available, you’ll always get the next message box onto the screen: 
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This is just an announcement. Please, use the above described procedure, to download 

the newest Service Pack: 

 

 
 

The updated files will be downloaded in your computer, in the Download folder, created 

in the CXSpectra directory. 

2.6 Installed applications 

 

By following the above instruction, you will install on your computer the following 

applications: 

 

CXSpectraTM - Analysis and Proactive Maintenance Software 

Test Protection Key - A fast way to test the functionality of your HASP protection 

key 

HASPUserSetup - A kit to reinstall the drivers for the HASP protection key 
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2.7 Local resources 

 

Once installed in a computer (workstation), CXSpectra™ can open many Machine 

databases existing in the computer or across the accessible Network. 

During runtime, CXSpectra™ software creates temporary files in the application directory 

(..\CXSpectra). It also creates a temporary directory under application directory, where 

the Service Pack package will be downloaded by Internet. 

 

CXSpectra™ always uses a series of files (databases or configuration files). The format of 

these databases is MS Access 2007. The databases described below are exclusively used 

by CXSpectra™ and they mustn’t be accessible within the network. CXSpectra.dat 

databases and Template.mts will be created by the application, if they don’t exist. 

2.7.1 Bearing.dat 

 

 
 

CXSpectra™ must have the right to: 

 open exclusive the database; 

 read a record; 

 modify a record; 

 delete a record; 

 add a new record. 

User access to database can be tested using an ODBC standard connection to a MS 

Access database. 

2.7.2 CXSpectra.dat 

 

 
 

 Code Table - Inspection codes for Route measurements 

 Setting - Contain Report Headers and Body templates (in RichText Format) 

 Server - List of available database server (MS Access) 

 Register- Contains the link of the registered databases for CXSpectra™.  
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This database is created on the first run of the CXSpectra™ with default values. The 

Register Table contains only DemoCX.db3 database (included in the Installation package 

and placed in..\CXSpectra\Data folder. 

CXSpectra™ must have the right to: 

 create the database; 

 open exclusive the database; 

 read a record; 

 modify a record; 

 delete a record; 

 add a new record. 

 

User access to this database can be tested using an ODBC standard connection to a MS 

Access database. 

2.7.3 Template.mts 

This is a complex structure database, similar with CXSpectra™ databases and it is used 

to store the Machine Template. 

CXSpectra™ must have the right to: 

 create the database; 

 open exclusive the database; 

 read a record; 

 modify a record; 

 delete a record; 

 add a new record. 

 

User access to the database can be tested using an ODBC standard connection to a MS 

Access database. 

2.7.4 CXSpectra.ini configuration file  

This is a standard Windows INI file, used to store some settings. Although the majority of 

the settings are stored in Windows Registry, the “.ini” file can be manually changed by 

the user. The user must be able to open the CXSpectra.ini file with a NotePad editor and 

to save the changes he has done. 

 

CXSpectra™ must have right to: 

 read items; 

 add items; 

 modify items. 

2.7.5 Constants.ini file 

It contains some coefficients used to create the Diagnosis Reports. The user must be able 

to open the Constants.ini file with the Notepad editor and to save the changes made. 

 

CXSpectra™ must have the right to: 

 read items only. 
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2.8 Public databases 

 

The main purpose of CXSpectra™ is to create and to update the so-called “Machine 

Databases” with measurements and notes. CXSpectra™ can create an unlimited number 

of Machine Databases. CXSpectra™ can create new databases or to register the existing 

Machine Databases created by another CXSpectra™ instance. 

 

The Installation Package includes a single machine database (MS Access type), named 

DemoCX.db3. This database is installed in...\CXSpectra\Data folder. 

 

User databases are created as default in...\CXSpectra\Data folder, but the user can 

decide to create the database in a shared folder, from his computer. 

 

The databases may be shared by many users across the network. Before using these 

databases, the user must register them (in his CXSpectra.dat database). The databases 

created by a user are automatically registered for its CXSpectra™ instance. 

 

After it has been created, the database can be populated and used by any CXSpectra™ 

instance. 

 

3 Running CXSpectra™ (for Win 7 and Win 8 only)  

 

 

CXSpectra™ is a safe application. All the files required by CXSpectra™ 

are located in the CXSpectra™ installation folder (excepting the 

Machine databases). 

 

CXSpectra™ uses its own Registers to save various settings, legally created in:  

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\CXSpectra registry 

folder. 

 

Also, the CXSpectra™ application doesn’t need a Write access either to any system 

folder, or to any existing folder from the computer. CXSpectra™ is running properly 

having the administrative privileges, but can run also under a normal user account. 

 

If CXSpectra™ cannot be run from a normal user account, you may need to give to the 

application more Administrative rights. This might be done in various ways. 

 

A simple solution is to use the RunasSpc application, available on: 

http://www.robotronic.de/runasspcEn.html 

 

It allows you to create a shortcut of CXSpectra™ with encrypted administrator 

credentials. So, CXSpectra™ will run with administrative privileges, even if starts from a 

normal user account. 

4 Trademarks 

 

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft 

Corporation in the United States and/ or other countries.  

 

All other brands or product names are trademarks or registered trademarks of their 

respective companies or organizations.  

http://www.robotronic.de/runasspcEn.html
http://www.robotronic.de/runasspcEn.html
http://www.robotronic.de/runasspcEn.html
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5 General Settings 

 

CXSpectraTM application can be configured using the Optional Settings command: 

 

All settings can be done in the followings tabs: 

 General 

 Trend 

 Spectrum 

 Report 

5.1 General tab settings 

 

        
 

 
 

In the window above, you can set the following: 

 Unit selection: Metric or Imperial 

 Frequency default unit: Hz or RPM. This setting can always be changed from the 

right-mouse popup menus, in the plots. 

 Alarm Status: Can be set on Enable or Disable. If the Alarm status is on Enable, 

the Refresh interval can also be adjusted. For further information read the Updating 

Alarms chapter. 

 Show all notes: As default, in the Notepad is shown only the record related to the 
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machine into the three. If you check this option, the Notepad will contain the whole 

machine history. 

 Language: Set the application Language. 

 Default Hierarchy Names: When a new item was added in the machine database, 

a default name appears for that item. You may change this default name in the 

Default Hierarchy Names window, as shown below: 

 

 
 

 Change Skin: Apply a personalized skin to all the application forms. 

When CXSpectra™ starts for the first time, the Operation System Color scheme is used 

by all forms. You may change this, applying a "skin" from a pre-defined list: 

 

 
 

See bellow some images showing how the forms look with various skins: 

 

 
 

Plain Black with Orange 
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Blue Default 

 

 
 

Win 8 Style 

 

 Check for update automatically: If this check box is checked, each time when 

the CXSpectra™ software starts, the application will check if a new Service Pack is 

available and will inform the user about this. If the computer doesn’t have a 

connection to the Internet, on start-up, this action may take a while. Check this 

box only if you have a high speed access to the Internet. 
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5.2 Trend tab settings 

 

 
 

Max. Number of spectra in trends: As default, this number is set to the   latest 23 

measurements plus baseline (if exists). This number is adjustable to any reasonable 

value. 

- Line width for trends can be adjusted to be 1 or 2 pixels thickness. 

- Live alarm change. If this setting is checked, you will be able to adjust the alarm 

limit in any trend plot. Just place the mouse cursor on the alarm border and drag it. 

Then save the newest value. See Trend plot for more details. 

- Trend plot default can be: 

 o Only vibration (or spectra) trend 

 o Vibration and BE trends 

 o All trends (Vibration, BE and Envelope) 

 o BE and Envelope 

- Envelope dB Scale: if this is set, the trend amplitude scale will be shown in dB 

instead of the vibration engineering unit, set in the Alarm panel.  
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5.3 Spectrum tab settings 

 

 
 

- Main cursor aspect (Line, Target or Cross) 

- Header aspect. If it’s set, the Total values will appear in the left side of the Spectrum 

window header. 

- Spectrum line thickness can be adjusted to one or two pixels. 

- Fault line fonts. This can be adjusted to be normal or small.  

- Number of harmonics and sidebands for various faults can be adjusted. 

5.4 Report tab settings 

 

 
 

The user can customize the Header and the Body of several available Reports. 

First of all, you must select the Report Title from the list, and then you will be able to 
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customize the Header and the Body. 

 

 Header design 

 

Header can be designed in the Header Editor. 

From the popup menu some reserved words can be added in the Header. These words 

(included in squared bracket) will be replaced with the actual data: 

[Data] - Computer date 

[Time] - Computer time 

[DBas] - CXSpectra machine database name. 

A designed Header can be saved into a file; so many headers can be used from the 

same report. 

 

 Body Design 
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The body design decides the contents of the Report. 

From the popup menu some reserved words can be added in the report body. These 

words (included in squared bracket) will be replaced with the actual data: 

  [MNam] - Actual name of the machine 

  [MPic] - Machine picture 

  [MDes] - Machine description 

  [MPar] - Machine plant (or Department) 

  [Note] - Notepad contents, edited before by the user. 

  [NDat] - The date when the notes have been edited. 
 

6 CXSpectra™ Overview 

 

CXSpectra™ software is mainly dedicated to implement a true Proactive Maintenance 

Program. 

For every plant, you can create a database, which can have an unlimited number of 

machines, points and directions. The spectra are stored at the level of the measurement 

directions. If you store more than two spectra for a direction, then you can display a 

trend. A trend can be shown for Total Vibration or for Bearing Energy Coefficient 

(BE). If the Envelope measurement is done, also Envelope spectra are available for 

trending.  

 

On the Machine level, the Manual Entry point can be added. The Manual Entry points 

are not measured points, but values entered directly using the keyboard. 

 

For the CXBalancer® Instrument you can also add Manual Entry points in the Route 

measurements. 

By default, only the latest 24 measurements are shown for one direction, but you can 

change this number using Settings > Optional settings command.  

 

The program allows to copy, via clipboard, any displayed graph (spectrum or trend) and 

to paste it later into a text editor (e.g. WORD) or in CXSpectra™ Notepad. The 

customized professional reports of the machines can be made this way. 

The machine Database stores machinery measurement, unloaded from the 

CXBalancer® instrument. 

The users can add, in the application Notepad, information following the diagnosis 

procedure. 

With the Database > Import command, external useful data can be added into the 

databases, regarding repair process, spare parts used etc. This information can come 

directly from CMMS or prepared, in a special format by the maintenance teams. 

That’s how valuable, complete information can be added, in time, for each machine in the 

databases. 

Analyzing this information, periodically, you can act proactively and to discover the real 

causes of the failures. 

The main purpose of using this software is to supply the maintenance team a periodical 

report regarding the necessary action, to maintain the machinery in od working 

condition. For this reason, CXSpectra™ can create a Job report. 

 

In order to analyze the collected data, you have on your choice many ways of viewing 

data: 

 A collection of trends and spectra selected by you (View > Show selected 

information). 

 A Quick View session, where you explore the machines, trends and spectra 

associated to the selected direction (View > Quick View). If Bands are defined, 

also Band Trends are available. Trends and spectra from the whole machine, 
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where you can see at once all these trends and spectra associated to the 

selected machine (View > Show spectra from whole machine). 

 A List View, where you can see at once all Total values (Vibration, Bearing 

Energy and Envelope) for the whole machine (View > List View). The Alarm 

status is also indicated. 

 A Band View, where you can see, at point level, all vibration total values and 

Band values (peak average for the band width). Alarm status for the above is 

also indicated (View > Band View). 

 GraphView is a special mode of displaying the data. A GraphView protection key 

is required. The GraphView project can be customized using the View > 

GraphView command. 

 

For all these views, a Notepad is available on the machine level, to type all the notes 

during the diagnosis process. 

 

Finally, chose the Report > Job Report command and you can customize a report for the 

maintenance teams, using all the notes supplied. Once you customize a Job Report, the 

appearance of this will be saved, and next time the report can be created faster. 

 

Job Report can be transferred into a text editor. You can then preview, modify and finally 

print the Job Report. You can also preview the report and send it directly to the system 

printer. 

 

From time to time, you will want to make a report regarding all the history of a selected 

machine. 

 

Use Report > Machine History command to do this. 

You can also customize the History report and then preview, modify and print it. 

The previously mentioned reports have distinct purposes: 

 

 The Job Report is addressed mainly to the maintenance team. 

 The Machine History is useful to take some proactive actions, before a failure of 

the machinery occurs. 

 

The CXSpectra™ software is a very flexible software and offers you many commands to 

do the same action in different ways. Before using the software, read carefully this 

document and, by using DemoCX databases provided in the installation kit, try to learn 

how to use efficient this powerful program. 

 

If you run this software for the first time, then you can use DemoCX databases which 

are included in the installation kit. So, you can learn how to work with the software and 

to evaluate the special performance of it. 

 

On the screen, a list of Menus and a Toolbar are displayed. In the Status Bar, on the 

bottom of the screen, the active database is also displayed. On the first run, the active 

database is DemoCX. Although you can create your own database, on the very 

beginning, just use DemoCX database to display spectra and trends. 

 

If you run the program for the first time, select Settings > Optional Settings command.  

Select the units (metric or imperial) and the measurement unit for frequency (Hz or 

CPM). For the moment, don’t change the number of spectra in trends. You can do this 

later. Click Save to save this setting. 

 

Choose from View menu, the Show Selected information command. A specific window will 

appear on the screen and it will allow you to choose the department, the machine, the 

point and the wished direction. Choosing is done by selecting a certain direction, with the 

mouse, in the above-mentioned order. When the direction is selected, in the upper right 
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side of it, a list with all collected measurements for that direction will appear. Coloured 

small icons indicate also alarm conditions for the measurements. A check mark icon 

indicates the baseline spectrum, if set. Now, you can select a collection of trends and 

spectra to be shown. 

Just double click any trend or direction and the item will be moved to the show list. 

 

Instead of double – clicking, you can drag and drop any Direction or Spectrum to the 

show list. 

If you want not to display some items from the show list, just double – click on that 

items and items will be remove from the list. 

 

Finally, press the Show button, and the entire list will be shown. 

 

After you have displayed some trends and spectra – set, the main window remains active 

and you can select other trends or spectra. Although it can display a large amount of 

information on a single screen, it is recommended to limit the number of simultaneously 

opened plots, because the plots will have smaller and smaller sizes and many details will 

be lost. 

 

For details regarding an efficient way of using the spectrum and trend plots, see also: 

 Spectrum plot 

 Trend plot 

 Frequency Response plot. 

 

Other ways for displaying data are: 

 Quick view 

 Show Spectra for the whole machine 

 List View 

 Band View 

Try also these commands to see the differences, but first read the help associated with 

the commands. 

 

 
 

 

  



MaintTech Sweden   

 

31 
 

 

7 Creating, registering and editing databases 

 

To make a functional program, every user has to create and edit its own database. 

For each part of a whole plant, it is recommended to create a separate database. 

7.1 Create a new database 

 

To create a new database use Database > Create command: 

 

 
 

Just press the Next button to continue. 
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Enter the database file name. 

Press Browse to locate the folder where the database will be created. If the database 

will be used in a Network environment it’s important to place all your databases into a 

single shared folder. In this example, the database file name is DEMODATABASE and the 

folder is E:\DATABASE.  

 

Optionally, you may give a friendly name for your database. In the CXSpectra™ this 

"alias" name will be used everywhere. If you don’t give any "alias" name, the application 

will replace CXSpectra™ name with the file name. 

 

 

     NOTE: To create a backup copy of your database, just copy the .db3 file into a 

safe location. 

 

 

Press Next to continue. The database will be created and the following info windows will 

be shown: 

 

 

7.2 Database registration 

 

Before using any CXSpectra™ database, you must register it.  

 

Use Database > Registration command to add an existing database to your 

registration list. 

 

 

  NOTE: The databases created as before, will be automatically added to the 

registered databases. 

 

To access another CXSpectra™ database into the network, you must register it first. 
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Click the Add button and select a valid CXSpectra™ database. 

You can add any existing CXSpectra™ database. 

  

 
 

Locate the database with the Browse button and click Open. 

Once added, just press Test connection button. If the database can be connected the 

following message will appear: 

 

 
 

Now, you can press OK to add the database in the list or you may press the Activate 

button first, to add the database to the list and activate it after pressing the OK button. 

 

Only the registered databases can be activated in the CXSpectra™ software. 

If the CXSpectra™ is installed into a network, each user can have his own database 

collection. 

 

You can always Remove a registered database. This doesn’t mean that you delete the 

selected database; you just remove it from the list. In addition, you can rename the 

“alias” name of the database. 
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7.3 Database change 

 

CXSpectra™ can manage many databases, but not simultaneously. This means you 

must select a particular active database (from the registered database list). 

 

Use Database > Change command to do this: 

 

 
 

Double-click the item in the list or select the database with a click, then press the 

Change button.  

To conclude, press the OK button. The name of the selected database will appear in the 

status bar (in the left side). 

 

 
 

7.4 Database edit 

 

Use Database > Edit command to edit a database. To do this, select this command 

from the main menu or press the dedicated button from the toolbar:  

 

This command is used for editing the active database (add, delete, rename items) and 

for database maintenance. In accordance with the selected item from the hierarchy tree, 

you can add machines, points or directions. 

1. Database Level 

On the Database level you can only add Departments (or plants): 
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2. Departments Level 

On the Departments level you can add Machines and you can also delete or rename 

Departments: 

 

 

3. Machine Level 

On the Machine level you can add Points. You can delete or rename the selected 

Machine: 

 

 
 

The following point types can be added: 

        Vibration point 

        Speed point  

        Manual entry point 

 

    Only vibration points have Directions.  

4. Point Level 

On the Point level you can add a Direction. You can delete or rename the selected 

Direction.  
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5. Direction Level 

On the Direction level you can delete or rename the selected Direction. You can also 

view the Trend plot (if any): 

 

 
After adding a new item in the database, any selected item can be renamed. The new 

items are added with a default name, which can be changed whenever required. To do 

this, select the name of the item you want to change and press the Rename button. 

Then change the name using the keyboard and complete with OK. An empty name is not 

allowed. 

 

To delete an item, just select it and press the Delete button. 

 

If the item isn’t the last one into the hierarchy tree or if there already are measurements 

stored in that particular direction, the item cannot be deleted.  

 

As a general rule, the deleting procedure must be done in the following order: 

measurement 

direction 

point 

machine 

plant (department) 

 
 

To delete spectra, you have to select one or more spectra and then to press the Delete 

button or the keyboard Delete key. The baseline spectrum can’t be deleted. First, 

double-click on the item, to transform the baseline spectrum into a normal spectrum 
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and then you can delete it. 

 

When you finish the machine definition (plant, machine, point and direction) on each 

level of the hierarchy, you can edit the fault frequencies that will be very helpful later. 
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7.4.1 Editing on machine level 

On machine level you can edit: 

 

A short description – This is a 30 ÷ 40 char length, description of the 

machine. This description can be used in reports. 

 

A machine description – pressing the Description button a text editor will 

appear. For each machine you can fill here as much information as you want. You 

can use different types of colours, letter sizes and alignments. You can import the 

contents of some external files (text or RTF file) or pictures. The contents of 

machine description can be printed with Report > Machine Description Report. 

 

A Machine picture: For each machine you can add a picture from the existing 

collection provided in the installation kit. The picture must be into a picture file 

format. Of course, you can make your own pictures with a digital camera. To add 

a picture to a machine, click Browse button and select any picture file. 

 

 
 

Reference speed: For each machine you can define 2 reference rotational 

speeds. The first is the primary reference speed, and the other one is the 

secondary reference speed, related to the first one. These speeds will be useful 

later, on the shaft speed definition for each point. In this respect, you can label 

these two speeds for an easier recognition in future. 
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For variable speed machines, define the primary rotational speed as zero. 

The software will determine the real shaft  speed using the latest 

measurement. 

 

For more details see Speed settings. 

 

Electrical motor fault frequencies 
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You can define the following fault frequencies: 

     Line frequency (LF) 

     Pole pass frequency (PP) 

     Rotor bar pass frequency (RBP) 

 

Belt fault frequencies 

 

 
 

          Multiply fault frequencies 

You can define five multiply fault frequencies for each machine: 
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7.4.2 Editing on point level 

 

On point level you can select or define a bearing and a shaft speed. The shaft speed can 

be one of the previously defined one or another related to the main reference speed, or a 

secondary reference speed. You can also edit the specific data for a gearbox. 

 

To select a bearing, press the Bearing button, then press the Library button. 

  

 
 

On each point you can add up to 4 bearings: 
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If the Library is selected, the Bearing Library window will appear. There are more than 

6000 bearing definitions in the library. The user can also add new bearing definitions in 

the Bearing Library Database. The Bearing Library window appears as follows: 

 

 
 

To add a new bearing into the Library, proceed as follows: 

Press New to add a new Manufacturer in the list. 

Press New to add a new bearing. 

 

 
 

 

If you know the fault coefficients, select the Edit frequency data option. 

 

If you know only the bearing dimensions, select the Edit dimensions option. 

 

Finally, press OK to save the bearing definition. 
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7.4.2.1 The automatic adjustment of pre-calculated bearing fault 
frequencies 

 

 
 
The bearing fault frequency can be displayed in any spectrum plot. A typical spectrum of 

a bearing with different faults was shown above. In most of the cases, the calculated and 

the measured frequencies will be separated by a small margin. 

 

In CXSpectra™ software there is a function, where the basic fault frequency lines with 

multiples are moved to the nearest peak, if there are some, within the selected gap. 

 

 
  

If there is more than one peak in this interval, the fault frequency line will be moved to 

the highest peak found. 

 

If the basic fault frequency is moved, the side bands will also be moved with the same 

distance. Because the distance between the measured and the calculated frequency can 

slightly vary from multiple to multiple, this adjustment will be separately done for each 

basic bearing fault frequency. 
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7.4.2.2 Speed and Manual points 

 

If the Point is Manual Entry or Speed, you can edit also the following: 

     - Alarm limits 

     - Unit name. Just add in the list a new name and this will be saved. 

     - Range scale (LO and HI). 

 

 
 

Just press the Save button to save the settings. 

 

Press the Copy button to copy the settings. 

 

Move to the next point and press the Paste button. 
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7.4.2.3 Editing gear box fault frequency 

 

Before setting the gear frequencies, set the proper calculated speed for each point of the 

machine. 

 

To define the fault frequencies for a gear box proceed as shown below. 

 

Press Gear button. The following window will appear: 

 

 
 

For the selected point, type the number of the gear teeth and select the conjugate point. 

If the conjugate point was correctly selected, the number of conjugate gear teeth will be 

an integer number and the OK button will be activated. Otherwise you cannot save the 

settings.  

 

Before saving the settings, type a label name for the gear mesh frequency. 

In order to better understand the gear box settings, please analyze the following 

example: 

 

The gear box has the following characteristics: 
 
 

Type:  

FLENDER Model KZN 280 

 

Z1=16 teeth 

Z2=26 teeth 

Z3=17 teeth 

Z4=47 teeth 

Z5=14 teeth 

Z6=45 teeth 

 

 

 

The teeth numbers give the following relationships between the speeds: 
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On the machine level, set the main reference speed to 3000 RPM and the label as 

“MotorSpeed”. 

Set the secondary reference speed to the output shaft (P4): 207.7467 RPM with the label 

“RollSpeed”. 

Add measurement points Intermediate 1 and Intermediate 2. They are required only for 

the calculations. 

 

For the input shaft (P3) set the shaft speed to be 1×Motor Speed. 

For the Intermediate 1 shaft, set the speed to 0.61538×Motor Speed = 1846.1538 RPM.  

For the Intermediate 2 shaft, set the speed to 0.22258×Motor Speed = 667.75 RPM. 

For the output shaft (P4), set the speed to 1×Roll Speed = 207.7467 RPM. 

 

Press the Gear button for the P3 point and make the settings: Number of teeth to 16 and 

label “GM1/2”. Select the conjugate point to be Intermediate 1 (26 teeth for the 

conjugate point will appear). 

 

Press the Gear button for the Intermediate 1 point and make the settings: Number of 

teeth to 17 and label “GM3/4”. Select the conjugate point to be Intermediate 2 (47 teeth 

for the conjugate point will appear). 

 

Press the Gear button for the point Intermediate 2. Number of teeth to 14 and label 

“GM5/6”. Select the conjugate point to be P4 point (45 teeth for the conjugate point will 

appear). 

 

Press the Gear button for P4 point. Set the number of teeth to 45 and label “GM5/6”. 

Select the conjugate point to be P4 point (14 teeth for the conjugate point will appear). 

 

Now the setting is complete. 
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7.4.3 Editing on direction level 

 Alarm settings 
 

 
 

On the direction level you can edit the alarm limit for total vibration values of 

measurements and also to define the Route settings. 

 

Press the Alarm settings button and you can edit two alarm levels for each overall 

vibration, BE and Envelope values. Two tables, the ISO 2372 diagram and the Bearing 

Energy Coefficient diagram, are on your disposition, to properly select the alarm value. 

Select the unit for total vibration values and the average type also. 

 

 

Note: If on Directions level there are already some stored measurements, you can 

declare, for each direction, one of them to be a Baseline. To do this, just double-click 

that measurement. Only one measurement can be a Baseline. All the other 

measurements are considered to be Normal measurements. 
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Click the Route settings to set some parameters for route measurements. 

 

 Route settings 
In the Database Edit window, press the Route Settings button: 

 

 
 

In the route can be set extra items: 

- Frequency range – can be selected from a list (1600, 3200, 6400 Hz) 

- Spectrum averages 

- Total value HP (none, 4, 8, 10 Hz) 

- Total value Frequency range–can be selected from a list (1000, 1600, 3200, 6400 Hz) 

- HP Filter for BE 

- Band pass filter for Envelope 

- Envelope spectrum averages. 

 

 Copy and paste settings 
Route settings can be copied and pasted to another direction or to the whole machine 

(for all directions belonging to the selected machine). Before copying the settings, you 

must press the Save button to save the existing setting of the selected direction. 
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7.4.4 Editing machine in batch 

 

If there are several identical machines in your database, you will edit only one machine 

and then copy and paste it several times. 

 

 
 

Before copying, the new machine must exist (only as name, the machine hierarchy can 

be empty). You can save a just created machine into a template database, or use the 

template database to copy a pre-defined machine into your database. When the 

CXSpectra™ starts for the first time, a file named: Template.mts will be created as 

default. The template file is empty. In this file you can add as much machines as you 

want. From the template file you can export some machine templates into other template 

files. Or from any template file you can import in your template file a series of machines 

(See Settings -> Template command). 

 

In the window above you can: 

Rename a machine (name, description and machine picture) 

Remove a machine from the Template file 

Edit the Machine Template description. 
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7.4.5 Change the hierarchy order 

 

The user can change the hierarchy. 

Any item can be moved, but only inside of the 

hierarchy (The Machines only under 

Departments, the Points only under Machines 

etc). 

To change the order in the hierarchy, proceed 

as follows: 

 

 

 

 

Select the item to be moved. 

Press the CTRL button. The buttons used to 

move the item will become Enabled. 

Now, you can move the item in the hierarchy in 

two ways: 

       - By using the UP and DOWN arrows 

       - By clicking the mouse onto the UP and 

DOWN buttons. 
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8 Off-route transfer for CXBalancer® 

The Off-Route measurements saved into CXBalancer® Instrument are normally binary 

files. Each measurement type is saved into files with the following extensions: 

Spectra  files: .cxs 

Envelope files: .cxe 

Frequency Response files: .cxr 

Balancing files .cxb 

Other files can also be created by special measurements into the CXBalancer® 

Instrument. 

There are two ways for files (measurements) transfer: 

Direct transfer, from CXBalancer® Instrument 

Indirect transfer, from any measurement file. 

8.1 Direct transfer 

Select the command Off route -> From Instrument 

If the USB cable is plugged-in, in the 

CXBalancer® a transfer window will appear. 

Normally, the CXBalancer® will automatically 

detect the microSD Card of CXBalancer®. If this 

doesn’t happen, you must manually locate the 

CXBalancer® mass storage unit: 

Now select the file type from the list: 
 

The existing files from the microSD Card will appear as follows: 
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You can show more information regarding the file contents, pressing the Info button. 

From the database tree, select a direction and then the Transfer button. 

In similar way, you can transfer any measurement type. 

8.2 Indirect transfer 

Select the command: Off route > From Files 

When this command is executed, the following transfer windows will appear: 

 

 
 

First, you must select the measurement type from the combo box. 

 

Press the Add button to add files in the left list. Multi-selection is also allowed. 

 

Select the disk unit, folder and the files. You can select one or more files to be added in 

the transfer list (multi-selection). 

 

You can press the Add button several times to add files from various locations. 

 

When consider the list was completed, you can transfer the file into database, on the 

direction level. 

 

You can also show more information regarding the files contents, pressing the Info 

button. 



MaintTech Sweden   

 

53 
 

8.3 Transfer Manual Points 

The points defined to be Manual  can be included into the measuring routes and can 

be transferred together with them. 

The user can transfer values to any Manual Point using the next command:  

 

 
 

 

 
 

1. Select or type the measurement date and time. 

2. Select the Manual Point. 

3. Type the measurement value (using the keypad or the virtual keypad). 

4. Press the Transfer button 

5. Optionally, you may show the trend plot. 

6. Continue as above for another Manual point or Exit. 
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9 Route transfer 

The following steps must be done in order to use the route transfer: 

· Create a route; 

· Download the route definition into CXBalancer® Instrument; 

· Perform the measurements; 

· Download the route measurements. 

 

 To create a new route: 

 Select Database > Edit Route menu. 

 

 
 

Press the Add button to add a new route in the list. 

From the machine database tree, select the first machine and press Add 

button. 

 

The selected machine will be added to the route structure. 

 

Proceed as above with all the machines. 

 

From the route structure, you can remove some points or directions. The removed items 

won’t be deleted from the database, but they only won’t be transferred into the Data 

Collector. 
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To remove an item, select it and press the Exclude button. 

 

Finally, press Exit to save the route definition. 

9.1 Download the route to/from CXBalancer® Instrument 

 
Select Transfer > CXBalancer Route > To/ From Instrument menu. 

 

Transfer can be done in two different ways: 

Direct transfer, from Transfer> CXBalancer Route > To/From Instrument 

menu 

Indirect transfer - In this case, using Transfer> CXBalancer Route 

>To/From Route file, the Route is converted to a file first. Then, the file can be 

simple copied onto the microSD Card of CXBalancer® Instrument (using Windows 

Explorer). 

 

If you have the Instrument and a computer with CXSpectra™ installed, the simple way to 

do this job is to use the first method.  

The following windows will appear: 
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If the microSD Card has the name “CXBalancer” and the USB cable is connected to the 

instrument, CXSpectra™ will automatically recognize the Instrument microSD Card. If 

this doesn’t happen, the user can manually browse to search the Card. 

 

Before transferring any Route contents into the machine database, use the Check File 

button and the selected file will be checked for integrity. If the file is OK, the following 

message will appear on the screen: 

 

 
 

The number of measurements will also appear in the Route List. For the unchecked files, 

a question mark appears. Another facility before transferring files is to have a look inside 

the selected route. Just press the Route Info button and you will be able to browse in 

the Route records: 
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Use the arrow buttons to make movements in the route list. You can see useful 

information regarding the route records. Finally press the Transfer button and the 

measurement will be transferred from/ to the Instrument. 

 

As you can see, any Route in the Instrument is a file. Transferring routes means to 

transfer files from and to the computer. In CXSpectra™ you can transform any Route 

definition into a Route file, using the indirect transfer mode.  

 

Use the commands Transfer> CXBalancer Route >To/From Route file. 

The window below will appear: 

 

Use To file button to transform a Route definition into a Route file. In addition, you can 

press the From File button and browse for a specific Route file. When the route file is 

opened, the measurements will be directly transferred into the machine database.  
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9.2 Using transfer options 

 

When the route was transferred from the Instrument, before exit, you can select the 

following options: 

 

 
 

Automatic Alarm Report: If this option is checked, after exiting the transfer 

window, a Transfer Report will be shown. 

 

Update alarm: If this option is checked, after exiting the transfer window, the 

Alarm Status of all measurements in the database will be automatically updated. 

 

10 Importing data 

 

External data can be imported in the machine Notepad using Import notes command 

from the Database Menu. With this command, you can complete your notes using 

helpful information from the maintenance team. The Import command is an easy way 

to add information regarding the repair process, the spare parts used or any other useful 

information, even picture or text file. 

 

To do this, you must prepare a text file first, with any name, but with the .imp extension. 

The following reserved words can be included into this text file, between square brackets: 

 

[PLANT] < plant name> <plant name> must exist in the database 

[MACHINE] < machine 

name> 
<machine name> must exist in the database 

[DATE] < date> in computer format (e.g. dd/mm/yyyy) 

[RTF] < file name> full path and name of a “Rich Text Format” file 

[FILE] < file name> full path and name of a text file 

[PICTURE] < file name> 
full path and name of a picture file in Windows graphic 

format 

[NOTE] 
Next lines will be considered to be notes to be added. Finish 

with other reserved words or with [ENDNOTE] 

[ENDNOTE]  

* It is considered to be comments. It is not transferred. 

 

For the DemoCX database, provided in installation kit, an import file example is: 
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Usually, the import files can be automatically generated by other computer software used 

in the maintenance activity. 

 

If CXSpectra™ cannot find a plant or a machine in your active database, an error 

message will be generated. If the software cannot find a specific date, it will add a new 

record to your database.  

 

 
 

When you execute this command, first press the Transfer button. A specific window will 

appear and you will be asked to select the transfer file, somewhere in the accessible 

network.  

 

Select the file and press Open.  

The import procedure will begin.  

 

Finally, press the Terminate button to finish the import procedure. 
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11 Database maintenance 

 

From time to time, just run the Maintenance command to optimize the dimensions of 

your databases. 

 

You can select two ways to delete some old measurements: 

by date 

by number 

 

 
 

The baseline spectrum will not be deleted. 

 

Notepad records associated with the measurements can be deleted only if the checkbox 

“Delete associated notes” is checked. 

 

The deleting procedure can take a long time, especially for long databases. 

 

Repair command can reduce the database size. 
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12 Database filters 

 

 Why to use a Filter? 
When a large CXSpectra© machine database is managed, you will find that is difficult to 

access a specific machine, point or direction. That’s why; the user can use a “filter” 

condition applied to the machine database, to reduce the items number. A filter is in fact 

a collection of some machines, points and directions, defined as a route. Many filters can 

be created for a machine database. This filter is named also Route. 

 

 How to build a filter? 
Any number of filters can be built using the Edit Filter command from Database  menu. 

Activate this command and the Filter Editor will be activated. Press the Add button to 

add a new filter.  

 

An existing Filter can be renamed or deleted by pressing the Rename or the Delete 

button. Once a new filter was created, you can add to the Filter as much machines as 

you want. To do this, just select any machine from the machine database tree area, and 

then press the Add button. In the same Filter a machine can’t be added twice. Instead of 

adding only one machine, you can directly add all the machines from a department.  

 

To do this, just select a department and press the Add button: 

All the machines belonging to the selected Department will be added.  

 

To remove a machine from the Filter tree, select the machine and push the 

Remove button: 

You can also remove a whole Department. To do this, select a Department 

from the Filter tree and press the same Remove button.  

 

From an existing Filter you can exclude any Direction: 

 
 

In a filter you can arrange the items using the Arrange  buttons. To do this, first press 

CTRL key from the computer keyboard, and then click on Up or Down  arrange buttons. 

 

 Filter activation 
To activate a filter, proceed as follows: 

Select Settings > Set filter. 

 

 
 

Select a Filter definition or a Route (A Route can be used whenever you want as a Filter). 
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You can press the Show button to see the Filter contents. The Filter Edit  window must 

be open. 

 

Pres the Change button to activate the filter. 

 

You can do the same from the CXSpectra™ Status bar. Just click the Filter icon: 

 

 
 

If a filter is active, the filter name will appear in the Status Bar also. 

 

In order to cancel the filtering, just select the whole database as a filter. In the above 

example the database name is DemoCX. 

 

 

 

 NOTE: When a machine is excluded while filtering a database, it is not visible in 

the database tree. 

 

 

 

 
 

In the below example, the DemoCX database tree will appear as follows: 

 

Only Department #1 is visible, because the Filter includes only this Plant. 

 

After the database name, the Filter name is also shown. 
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13 Viewing plots 
 

CXSpectra™ can display the followings plots: 

Trends (for total value, BE, Envelope, Speed, Manual Entry values) 

Spectra (for vibration measurement and Envelope). 

 Frequency Response graph 

 Waterfall plots 

13.1 Trend plots 

 

Trend plots can be shown for any View or from Edit window. 

 

When a Trend Plot is shown, you can take a large number of actions to customize the 

graph. Most of these actions can be done using the pop-up menu, activated by the right-

mouse button. Other actions may be taken using the mouse or/and the keyboard. 

 

You can also use the dedicated buttons from the Toolbar. 

13.1.1 Actions with the mouse and/or keyboard 

 

In the next picture you can see all the actions you can take using the mouse or the 

keyboard. 
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Unit and average – The trend unit for the Total value of vibration is, always, in 

accordance with the Alarm levels setting (in Edit Database window). The unit and the 

average can’t be changed. 

 

Gain – When the trend is shown for the first time, the gain is set in respect of the 

highest Total value from the trend (AUTO mode). The gain can be changed by clicking 

and dragging the upper horizontal line of the grid. If you drag it down, the gain will 

decrease; if you drag it up, the gain will increase. A double click into the Y-axis label area 

will restore the auto-gain. The gain for BE can’t be adjusted. 

 

Cursor – When a trend is shown, the cursor is placed onto the last (most recent) 

measured point. You can also place the cursor into another position, using the mouse 

(click in the new position) or using the left and the right arrows from the keyboard. If the 

synchronize cursor command is checked, depending on link level (Synchronize to menu), 

the cursors will move into other trend. 

 

Live alarm limit change – When the option “Live alarm” is activated in Optional Setting 

menu, you can change live alarm limits. Just place the cursor on the alarm limit border, 

click and drag to modify the alarm level. In the Trend toolbar press the Save button to 

store the new alarm limit into the Machine Database. 

13.1.2 Actions from the pop-up menu 

 

The Trend Menu can be activated in each Trend Plot, with a right click on the mouse. 

The menu has the following actions: 

 

Copy – This action copies the plot onto the clipboard or in 

a text editor. You can also use CTRL+C. You can paste the 

clipboard contents in the Notepad, with CTRL+V. 

 

Grid – The grid of the trend can be shown or hidden using 

this action. 

 

Show spectrum – Selecting this action, the spectrum 

associated with the trend cursor will be shown. 

 

Show waterfall – Selecting this action, the waterfall 

spectra associated with the trend will be shown. 

 

Show Notepad – Selecting this action the Notepad 

associated with the trend will be shown. Notepad can also 

be activated with the specific button from the toolbar. 

 

Show machine picture – If you select this action, the machine picture will be shown 

into a separate window. 

 

Alarm limits – You can make visible the alarm limits for the selected trend using this 

action,  

 

Show same plots – can be used, when more than a single trend window is visible. If 

this line item is checked, when you select into a trend one of the graphs, the same graph 
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will also be selected in all the visible trends.  

 

 
 

Same cursor – this action activates or deactivates the linking between the cursors for 

the other trend plots. If a large number of trend plots are displayed, it is better not to 

synchronize the cursors. 

 

Use same amplitude scale for all – This command is an action that adjusts the gain for 

all trends in accordance with the active trend gain, depending on the link level. 

 

Same active plot can be used, when more than a single trend window is visible. 

If this line item is checked, when you select one of the graphs in a trend, the same graph 

will also be selected in all the visible trends.  

 

Link to – You can synchronize trend cursors and make the same gain for all the trend 

plots, depending on link level: global (for all active trends), machine or point level. 

 

Colours – You can customize the colour for: 

Main cursor 

Axis background 

Axis foreground 

Trend grid 

Trend - overall line 

Trend - bearing line 

Trend - Envelope line 

Trend background 

Active plot border 

 
 

You can save these new colours using the Save command. You can restore the default 

colours using the Set Default command. 

 

Report - Using this command, a trend report will be generated. After previewing, you 

can print the report to the system printer. The Report can be also directly made in a text 

editor. 
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13.1.3 Actions from the Main Toolbar 

 

Notepad button – When this button is pressed, the Notepad will be activated 

in accordance to the active Trend plot. 

 

 

13.1.4 Multitrend 

 

When a trend is shown, it appears as it follows: 

 

 
 

The default plot is Total value (or Overall) trend. 

The name of the plot appears now in the upper part of the trend graph. 

 

Pressing the first three buttons from the toolbar, you can select the plots to be shown in 

a single window. 

 

The selection can be: 

Total value trend only; 

Bearing Energy trend only; 

Envelope trend only; 

Any combination of above. 

 

There are two examples below: 
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1. Total value + Bearing energy 

 

The selected plot has a coloured border. The cursor may be moved with the left and the 

right arrow keyboard keys in the selected plot. Because the cursors in the plots are 

synchronized, the cursor will also be moved in the remaining plots, but if the same date 

is not available, the cursors will be placed onto the closest position, in respect with the 

cursor of the selected plot. 

The amplitude scale can be individually changed for each plot. Just drag the upper graph 

line and the amplitude scale will be changed. You can drag the line up or down to 

increase or decrease the scale. In the trend plot, the unit and the average can’t be 

changed. You can do this only in the Database > Edit > Alarm settings window. 

 2. Total value + Bearing Energy + Envelope 
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13.1.5 Live Alarm limits changing 

If in Setting -> Optional settings -> Trend you will enable the option Live alarm 

change, then the alarm limits in trend might be changed "live": 
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1. Click on the edge limit of the alarm. 

2. Drag the alarm limit line up to a new position 

3. Press the Save button to change the alarm limit permanently. 

 

Both Warning and Danger limits can be changed. 

"Live" alarm limits can be changed in Vibration, BE or Envelope plot. 

13.2 Spectrum plots 

 

When a spectrum plot is shown, you can take a large number of actions to customize the 

graph. The majority of these actions can be done using the pop-up menu, activated by 

the right-mouse button.  

Other actions can be taken using the mouse or/and keyboard. 

 

You can also use the dedicated buttons from the Toolbar. 

13.2.1 Actions with the mouse and/ or the keyboard 

 

In the following picture you can see all the actions you can take using the mouse or the 

keyboard. 

 

 
 

Gain – When the spectrum is shown for first time; the gain is set in respect with the 

overall value of the vibration (AUTO mode). The gain can be changed by clicking and 
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dragging the upper horizontal line of the grid. If you drag and drop the line down, the 

gain will decrease and if you drag it up, the gain will increase. A double – click in Y-axis 

label area will restore the Auto gain. 

 

Frequency range – If you click and drag the Y–axis of the plot, you can adjust the 

minimum frequency. If you drag and drop the line to the right, the minimum frequency 

will increase. 

 

Similarly, you can increase the maximum frequency, by clicking and dragging the last 

vertical line of the grid. The difference between 

the maximum and the minimum frequency should 

be at least 50 Hz (3000 RPM). A double click onto 

the X-axis label zone will restore the whole 

frequency range. You may press also the Restore 

icon: 

 

Zoom – You can enlarge the plot by double-clicking anywhere into the blue banner area. 

To restore the spectrum plot at the initial size, just press the Restore down button in 

the gray spectrum plot banner area. 

 

Main cursor – The main cursor may be activated with a click into the plot area. The 

main cursor has an associated label. You can also use the Left or the Right arrow keys for 

a smooth movement of the cursor or CTRL + Left (CTRL + Right) arrow keys for a fast 

movement of the cursor. Press keys 0 to 9 to move the cursor to the shaft frequency or 

to its harmonics. Move the cursor label up or down using the UP/DOWN arrow keys. 

 

Shaft Speed cursor – The shaft speed cursor is shown as a small triangle near the X-

axis; using the mouse, you can adjust the position of this cursor. 

13.2.2 Actions from the pop-up 

menu 

The Spectrum Menu can be activated in each 

Spectrum Plot with a right click on the mouse. 

The Menu has the following actions: 
 

Copy – This action copies the plot onto the 

Clipboard. You can also use CTRL+C. You can paste 

the clipboard contents in the Notepad with 

CTRL+V. You can also copy the plot in a MS Word 

document file. The first copy action in MS Word will 

open a new document. Consecutive copy actions 

will insert the plots (any of them) in the same 

document file.  

 

Grid – The grid of the spectrum can be shown or 

hidden, using this action. 

 

Show trend – Selecting this action, the trend 

associated with the spectrum will be shown. 

 

Show Notepad – Selecting this action, the 

Notepad associated with the spectrum will be 

shown. The Notepad can also be activated with the 

specific button from the toolbar. 

 

Show machine description – The machine 
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description editor will be opened. 

 

Show machine picture – The machine picture will be shown. 

Reference spectrum – The reference spectrum (Baseline spectrum), if exists, will be 

drawn in the same plot with black lines. The Reference spectrum has its own cursor, 

synchronized with the Spectrum cursor. Using the mouse, pointed in the origin of the 

Reference spectrum axis, you can move the reference spectrum wherever you want onto 

the plot area. If you want, you can place the reference spectrum over the actual 

spectrum. 
 

Main cursor – Determine how the cursor will move in the plot: 

Peak locked – When a peak is detected, the cursor will be placed on the maximum 

calculated peak. A small blue icon will indicate the peak detection. If a peak is not 

detected, the cursor will move with spectrum resolution steps. 

Frequency line – The cursor will follow the spectrum lines. 

Free – The cursor is moved with one pixel step. The peak amplitude will be 

calculated with a linear interpolation between the spectrum lines. 

Speed tools – Determine how the software will place the speed arrow: 

Calculated – The speed arrow will be placed onto the position calculated from the 

actual spectrum (around the defined values). The software tries to detect a peak (a 

higher line between other two smaller lines), around the defined shaft speed. If a 

peak is found, the exact frequency and peak amplitude are calculated. If a peak isn’t 

found, the speed arrow is placed on the defined frequency. If the defined frequency 

doesn’t exist, the cursor is placed onto the calculated frequency, near the highest top 

in the spectrum.  

Defined – The speed arrow will be placed in the frequency defined in Database edit 

menu. 

Measured – The speed arrow will be placed where it was measured. If the shaft 

speed wasn’t measured in the meantime of spectrum acquisition, the cursor will be 

placed into the defined position. 
 

 
 

Saved shaft speed – The speed arrow will be placed in the position saved before, 

using the Save speed current command. The speed value is saved only for the 

selected spectrum or for all spectra belonging to the machine (see Adjusting speed 

paragraph). 
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Warning: The highest top in a spectrum is not necessary the same with the 

revolution. It can be due to misalignment (twice the revolution frequency) or 

for example by a gear box. 

 

Harmonic cursors – By default, up to 10 harmonic cursors can be shown, together with 

the main cursor, but you can change this number in the Settings > Optional settings 

menu. 

Side band cursors – As default, up to 10 side band cursors can be shown, together with 

the main cursor, but you can change this number in the Settings > Optional settings 

menu.  

 

Defect frequency cursors – This is a powerful tool for fault identification. In a toolbox 

window, all the defined fault frequencies will appear. 

 
 

Any selection will update into the real time the spectrum plot. The last selection is also 

saved to be available later on. 

 

Fault list – The Fault list table will be displayed. You can also do this action from the 

Main menu toolbar. Depending on the gap setting, the labels attached with the fault 

frequencies will also be displayed accordingly. 

 

Show with- Same cursors – If, on the screen, more than one spectrum are displayed 

and you select this action, the cursors from all spectra plots will be synchronized, 

depending on the link level (Link to action). 

 

Show with - Use same – This action sets the synchronism level for range, if more than 

one Spectrum is shown. You can select between the Frequency range and the Amplitude 

range or for both. 

 

Show with - Link to – This action sets the synchronism level if more than one Spectrum 

is shown. The synchronism level can be Global (for all the spectra plots), on machine 

level, on point level or on direction level.  

 

CPM/ Hz – You can change anytime the Y-axis unit, selecting CPM or Hz. 
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Colours – You can customize the colours in the spectrum plot. You can change the 

colours for: 

Main cursor 

Harmonics cursors 

Bearing cursors 

Axis background 

Axis foreground 

Overall bar graph 

Spectrum grid 

Spectrum line 

Spectrum background 

 
You can save these new colours for your database, or to restore the original colours, 

using Set default command. 

 

Export – You can export the whole spectrum in any transfer file (having extension .tr3) 

 

Report – Using this command, a spectrum Report will be generated. After previewing, 

you can print the report to the system printer. For more details see Report preview.  

 

The Report can also be transferred in a MS Word Document. If there is no document 

opened, a new document will be opened. Consecutive reports will be inserted in the same 

document file. 

13.2.3 Actions from the Main Toolbar 

 

 
 

In the Main Menu some Toolbar buttons are dedicated for Spectra Plots: 

 

Notepad button – When this button is pressed, the Notepad will be activated in 
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accordance with the active Spectrum plot. 

 

Dynamic table – A table with the first 30 fault frequencies can be displayed: 

 
 

Fault toolbox – Activating this action, the Fault frequencies toolbox window will be 

displayed. 

 

Gap – Depending on the gap, in the dynamic table less or more frequencies can be 

labeled. 

 

 
 

If the gap is too small and the fault frequencies aren't equal with the fault definition, plus 

or minus the gap value, in the place of the label a question mark will be displayed. If the 

gap is too large, for the same frequency, more than one label will be displayed. 

 

Zoom – This action can be used for a fine tuning of the shaft speed: 
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13.2.4 Other settings for the spectrum plot 

 

The main cursor shape can be selected using the Optional Settings command from the 

main Settings menu. 

 

 

 
 

Main cursor can be: 

Line (default) 

Target type 

Cross type 

 

Just click the option you want and the cursor shape selected will be displayed into the 

spectrum plot from now on. You can also adjust the cursor thickness (default is 1 pixel). 

 

The thickness of the spectrum line can be adjusted with a proper setting of the Width. 

 

Maximum number of harmonic cursors and sideband cursors can be adjusted in the 

same tab. Once set, any of the above will be saved into the CXSpectra.ini file. 

13.2.5 Adjusting speed 

 

A major task in the spectrum analysis is to determine, with a higher accuracy, the correct 

speed for each spectrum. Almost all fault frequencies are associated with the shaft 

speed. Any small error in shaft speed determination can produce larger errors in the fault 

frequencies calculation and, as a consequence, a poor diagnosis process. 

 

A proper solution might be to measure the spectrum from the route, using speed 

reference (active tachometer input). This action is difficult to be done in most of the 

cases, because a speed sensor must be fitted to each machine shaft. 

 

The method of the Measured speed, described below, allows a correct shaft speed 
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calculation, even if only a single measurement belonging to the machine has a speed 

reference. The algorithm also works if the machine has different shaft speeds. 

 

The method using the Saved speed, allows a correct shaft speed calculation, without 

collecting any spectra with the speed reference sensor. For a single spectrum belonging 

to a machine, the speed must be manually set. Then, using a back-calculation, all the 

spectra will appear with the correct speed cursor. 

13.2.5.1 Using the Measured Speed 

 

For a new unloaded spectrum, having the speed measured during the data acquisition, 

the Speed tools menu appears as below: 

 

In this example, the Measured shaft speed is 2952.1 RPM. 

The Saved shaft speed item is disabled, because no other 

speed was saved before. Because the Defined speed is set to 

7560 RPM, the Calculated speed, in our example, is the same. 

The Calculated speed is calculated around the Defined shaft 

speed (± 20%). 

 

For a new unloaded spectrum, without speed measurement during the data acquisition, 

the Speed Tool menu appears as below: 

 

 

The Measured item is disabled, because the speed wasn’t 

measured during data acquisition. 

The other items remain the same. 

 

 

 

To set the proper shaft speed for all machines directions, proceed as follows: 

 Identify the spectrum having the Measured item enabled. 

 Click onto the Measured item to extend the menu lines: 
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 Select Set to all points menu. The proper shaft speed will be back-

calculated, using the speed settings in the database, for all the 

measurements belonging to the same machine and having the same 

transfer time (in fact, this means that all the transferred measurements 

from the route belonging to the same machine will be set with the 

Measured speed). 

 

The result can be immediately seen; just select another spectrum of the same machine 

and the Speed Tool menu will look like below: 

  

In our example, the measured speed for this shaft is back-

calculated to be 1230 RPM. 

 

The calculation uses the measured speed of the previous 

point as reference. 

 

In the Quick View, you can do the settings in seconds. 

 

Now, all the spectra of the same machine, without being collected with speed reference, 

have the speed cursor in the correct position. Of course, it is assumed that during data 

acquisition, the machine speed remains the same. 

13.2.5.2 Using the Saved Speed 

 

For a new uploaded spectrum, without speed measurement during the data acquisition, 

the Speed Tool menu appears as below: 

 

 

Measured item is disabled, because the speed wasn't 

measured during data acquisition. 

 

Saved shaft speed item is also disabled, because no other 

shaft speed was saved. 

 

To set the proper shaft speed for all machines directions, proceed as follows: 

 

 
Select any spectrum of the same machine. 
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 Manually move the shaft speed cursor near the frequency where you 

consider that the speed is correct. 

 From the Main menu toolbar, press the  button. 

 In the enlarged spectrum graph, locate the Best shaft position. This is the 

top of the peak, as beside: 

 Now press again the  button to display the whole spectrum. 

 From the Speed tools item, select the Save current speed and Save to 

all points items. The proper shaft speed will be back-calculated, using the 

speed settings in the database, for all the measurements belonging to the 

same machine and having the same transfer time (in fact, this means that 

all the transferred measurements from the route, belonging to the same 

machine will be set with Saved shaft speed). 

 

 
 

The result can be immediately seen; just select another spectrum of the same machine 

and the Speed Tool menu will look as below: 

  

The Saved shaft speed is checked, even if it wasn’t saved for 

this measurement. 

 

The calculation uses the measured speed of the previous point 

as reference and the speed cursor in the spectrum is placed 

according with the calculation. 

 

In the Quick View, you can do the settings in seconds. 

 

Now, all spectra of the same machine have the speed cursor in the position that you 

decided. Of course, it’s assumed that during data acquisition, the machine speed remains 

the same. In such cases, the fault frequencies are calculated with a high error margin. 

Besides, all the other spectrum lines have zero amplitude values. 
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13.2.6 Spectrum in mV unit 

 

With the CXBalancer® Instrument, mV spectra can be measured, but only off-route. 

These spectra have a special meaning: the engineering unit can be any, not only 

vibration units. 

 

The mV spectra can be shown only in the Edit window and in List View. 

An mV spectrum is shown below: 

 

 
 

When the mV label is selected, the following window will be displayed: 

 

 
 

Now, you can edit the unit and set the correct transducer sensitivity (in mV/unit). The 

settings will be saved in the database. 

13.2.7 dB Scale in the Envelope Spectrum (ESP)  

13.2.7.1 The Decibel (dB) Scale 

Envelope data is often displayed in a logarithmic scale called the Decibel (dB) scale. This 

scale is useful, because vibration levels can vary from very small to very large values. 

When plotting the full data range on most scales, the small signals become virtually 

invisible. The dB scale solves this problem, because it compresses large numbers and 

expands small numbers. A dB value can be computed from a linear value by the 

equation: 

 
For acceleration, zero reference (xref) is set 1 μg, or 10-6 g. 

Any increase in level of 6 dB represents a doubling of amplitude, regardless of the initial 

level. In such a manner, any change of 20 dB represents a change in level by a factor of 

ten. Thus, any constant ratio of levels is seen as a certain distance on the scale, 

regardless of the absolute levels of the measurements. This makes very easy to evaluate 

trended Envelope spectral data; 6 dB increases always indicate a doubling of the 

magnitudes. 
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13.2.7.2 dB Values vs. Amplitude Level Ratios 

The following table relates dB values to amplitude ratios: 

 

dB Change 
Linear Level 

Ratio 
dB Change 

Linear Level 

Ratio 

0 1 30 31 

3 1.4 36 60 

6 2 40 100 

10 3.1 50 310 

12 4 60 1000 

18 8 70 3100 

20 10 80 10,000 

24 16 100 100,000 

13.2.7.3 Showing Envelope trends in dB 

The Envelope trend graph can show the amplitude in g (EN unit as default) or in dB. 

Only one of the above can be used for all Envelope graphs. 

Selecting the way of displaying the Envelope scale can be done in the Optional Settings, 

tab Trend. 

13.2.7.4 Showing Envelope spectrum (ESP) in dB 

The Envelope spectrum will be shown, as default, with the above settings. 

You can still change live the scale style: 

 

 
 

Just click on the on the list and select it. The unit selection is valid only for that Envelope 

Spectrum graph and it will not be changed in any other graph from the screen. 

The Defect List will be changed and it will show the Envelope lines amplitude in the 

selected unit. 
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13.2.7.5 Determination of Bearing Damage Severity 

The decibel scale can be used very easily to diagnose bearing defect. 

As nominally healthy rolling element bearings will exhibit vibration at the particular 

defect frequencies, it is extremely important to be able to accurately gauge the presence 

and indeed the severity of bearing deterioration.  

Fortunately, a convenient rule-of-thumb can be established for severity assessment. This 

involves measuring the amplitude of the specific component in dB above the “carpet 

level” of the Envelope spectrum (Carpet level is the middle of the signal level, in dB). 

 

• 10 dB above the carpet level of the spectrum is considered as indicative of the 

onset of bearing failure. 

• 15÷20 dB above the carpet level of the spectrum is generally considered as 

sufficiently high to trigger some form of remedial action, either increased 

monitoring or, at least, bearing lubrication. 

• 20÷40 dB above the carpet level of the spectrum combined with sidebands 

(usually at 1 x RPM or Cage defect frequency - FTF) is considered to require 

immediate action. 

• The final sign of bearing deterioration is a 20÷30 dB rise of the carpet level. 

• A carpet increase of 10 dB without defect frequency tonal can indicate a poor 

lubrication. 

 

 

Note: In extremely badly damaged bearings, the carpet level can rise to obscure the 

bearing fault frequencies. As the carpet level begins to rise, a vibration reading in units of 

velocity will start to exhibit a small spike at the bearing fault frequency. A spike of 0.2 to 

1 mm/s indicates definite spalling of the bearing. 

 

 

Figures 1 and 2 illustrate the ESP (Envelope Signal Processing) Spectrum data collected 

from the Motor Non Drive end bearing positions of two identical Compressors. 

 

 
 

Fig. 1- Compressor 1 Motor NDE ESP Spectrum 
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Fig. 2 - Compressor 2 Motor NDE ESP Spectrum 

 

The carpet level comparison reveals a carpet or threshold of 90 dB exhibited by Figure 2 

as compared with 105 dB exhibited by Fig.1. This is a difference of some 20 dB, or 

approximately 1000%. 

 

 
 

In the figure above, the software diagnostic features have been utilized to highlight the 

peaks of interest on the ESP data collected from Compressor 1. The speed and bearing 

type have been entered, and the system has generated the bearing fault frequencies 

associated with this particular type of bearing.  

The conclusion is that there is clearly a defect on the INNER RACE of this bearing. 
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The fault frequency is some 15÷20 dB above the carpet, which would not usually cause 

great concern, however, the presence of harmonics at 2 x INNER, 3 x INNER and 4 x 

INNER combined with the high carpet level led to a recommendation to replace the 

bearing. 

13.2.8 Viewing whole frequency range 

When viewing the vibration spectra, the frequency range is 1 kHz set by default. 

So, the 1× RPM, 2  RPM a.s.o. peaks might be seen better. 

 

If the spectrum range is larger than 1 kHz, the amplitudes exceeding this value won’t be 

visible, but this aspect might be changed, because in the right side down of the graph 

appears an icon that indicates the range might be expanded: 

 

 
 

To expand the frequency range, just make a mouse-click anywhere in the lower part of 

the graph, where appears the frequency range. 

 

13.2.9 Zoom Tool Options 

 

A series of zooming tools is available in the spectrum plot. 

 

This can be activated in two ways: 

 By pressing the Zoom button from the spectrum toolbar 

 By moving the mouse pointer in the far left side of spectrum plot. 

 

In both cases, the Zoom Tools will appear: 
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Just click on the magnifying glass icons to give a different zoom option for a closer 

examination of the spectrum plot. 

These tools allow the user to zoom in/out on the horizontal or vertical axis and pan left, 

right and top.  

 

  Zoom the plot on vertical direction. When this icon was selected, just place the 

mouse anywhere in the plot area, click the right - button and drag the mouse pointer. 

When the mouse right - button is released, the plot will be zoomed according with the 

highlighted region: 
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  Zoom the plot onto horizontal direction. Proceed as above. 

 

 Zoom the selected region. Proceed as above. 

 

 Zoom spectrum to optimum zoom. To do this, just click on the icon. 

This action can also be done by clicking on the left plot side and then on the bottom plot 

side. 

 

Pressing X1.... X10 button, the cursor will be place on the selected harmonic. (These 

buttons are disabled in Spectrum ZOOM mode and in the time - signal plot). 

 

MAX - Find the maximum amplitude peak in the plot area. (This button is disabled in the 

time - signal plot). 

13.3 Waterfall spectra 

 

Waterfall spectra can be shown from the Trend pop-up menu: 

 

 
 

Select Show Waterfall command. 

 

The waterfall graph for the last ten spectra will be shown. 

 



CXSpectra™ Manual Version A 

 

 86 

 
 

Using the mouse you can: 

1. Left-click in the plot area. This action will make the spectrum cursor visible 

(for the active spectrum) 

2. Left-click on the date labels. You will change the active spectrum. 

3. Left-click and drag the small black circle. This action will change the graph 

perspective. 

4. Left-click and drag the windows to zoom-in or out the whole graph. 

5. Right-click to show the windows pop-up menu. 

 

With the Keypad: 

 Press Up or Down keys to change the active spectrum 

 Press Left or Right keys to change the cursor position in the plot. 

 

Using the pop-up menu you can: 

*Copy the graph in the clipboard 

*Show/hide the Notepad 

*Show machine description 

*Show machine picture 

*Zoom in or out the frequency scale 

*Show default graph. The perspective and the frequency 

scale will be changed to initial values. 

*Change the frequency scale from Hz to RPM or reverse. 

 
 

You can open as many Waterfall windows you need. The spectra contents will not be 

updated when you change the active trend. 

13.4 Frequency Response plots  

 

The Frequency Response graphics may be collected off-route only. 

 

These graphs can be viewed only in the Edit window or in Show selected information 

view. The plot can be: 

  - Bode Plot (as in the picture below) 

  - Polar Plot. 
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 Bode Plot 

 

 
 

Each Bode plot has a pop-up menu: 

 
 

The user can change the frequency unit (RPM or Hz). 

The plot colours can be changed using the Colour menu item. 

From the pop-up menu, the user can copy the graph onto the Clipboard 

or in MS Word and also create a report. 

 

 

 
  



CXSpectra™ Manual Version A 

 

 88 

 Polar plot 

 

Polar plot is made up of a set of vectors at different speeds. 

 

 
 

     - Vector arrow is omitted and the points are connected through a line. 

    - Zero degree is aligned with transducer location. 

    - Phase lag increases in the reverse direction of rotation. 

 

Bode Plot  and Polar Plot  show the same details: 

• Polar Plot  displays the same “vibration vector data” as the Bode Plot.  

• In Bode Plot  vibration amplitude and phase are separately plotted on two 

plots with the speed on the horizontal axis. 

 

 

 

  



MaintTech Sweden   

 

89 
 

 

13.4.1 Detecting Resonance with Bode & Polar Plots 

 

 
 

In a Bode plot, the resonance is indicated by peak amplitude and sharp, significant 

change of phase at peak frequency. On the Polar plot, resonance will produce large, 

curving loops. Small system resonances are more easily visible as distinctive small loops. 

Polar Plot can be shown in the Coast-Up/ Coast-Down (Bode Plot) window, just 

pressing the Polar Plot button from the toolbar. 

 

 
 

The Polar Plot windows have two parts: 

 The Polar Plot diagram (on the left side) 

 The measurement list (on the right side). 
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The cursor position can be settled in two ways: 

- Click on Polar Plot area and use Left and Right arrow key. 

- Click into the Measurements List area and use the Up and Down arrow 

keys. 

 

You may directly select a vector in three ways: 

- Click on any measurement dot (small black square). 

- Click on any item from the Measurements List. 

- Click on the Bode Plot toolbar button to return to the Bode Plot windows 

and select any point from the graph. Click to the Polar Plot toolbar button 

again, to return to the Polar graph. As can be seen, the cursors from Bode and 

Polar plots are synchronized. 

 

The Polar Plot label shows the selected point details, as follows: 

 

 

The label can be moved with the mouse (just click on the label and drag it in a 

convenient position). 

With a right mouse click you can activate the Polar Plot popup menu, having the following 

commands: 

 

 
     Copy to clipboard or in MS Word the Polar Plot 

     Show/hide grid 

     Change the frequency unit (RPM or Hz) 

     Export the measurements into a transfer file 

     Create a report (in Print Preview or in MS Word). 
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The copied Polar Plot appears as follows: 

 

 
 

The report also contains the whole measurements list. 

13.4.2 Multiselection 

 

To see only a part of the Polar Plot, you must select first the measurements: 
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Click on first item. Press Shift key and select the last item. 

Selection will be shown as above. 

 

Press Refresh button . 

 

Now, in the Plot area only the selected point will appear. 

The plot will be re-scaled to the optimum zoom. 
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14 Viewing data 

 

In order to analyze the collected data, you have on your choice many ways of viewing 

data: 

A collection of trends and spectra selected by you (View > Show selected 

information). 

A Quick View session, where you explore the machines, to see the trends and the 

spectrum associated with the selected direction (View > Quick View). If Bands are 

defined, also Band Trends are available. 

Trends and spectra from the whole machine, where you can see at once, all these 

trends and spectra associated with the selected machine (View > Show spectra 

from whole machine). 

A List View, where you can see at once, all Total values (vibration, Bearing Energy 

and Envelope) for the whole machine (View > List View). The Alarm status is also 

indicated. 

A Band View, where you can see, at point level, all total values of the vibration and 

Band values (peak average for the bandwidth). The alarm status for those above 

mentioned is also indicated (View > Band View). 

14.1 Show selected information 

 

When you select this command, a specific window will appear on the screen and will 

allow you to choose the department, the machine, the point and the wished direction.  

 

 
The choice is made by selecting a certain direction, with the mouse, in the above-

mentioned order. When the direction is selected, in the upper right side will appear a list 

with all collected spectra for that direction. The coloured small icons also indicate an 

alarm condition for the measurements. 
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A check mark icon indicates the baseline spectrum, if any. The Coast-down 

measurements are marked with a blue icon. Now, you can select a collection of trends 

and spectra to be shown. Just double – click on any trend or direction and the item will 

be moved to the show list. 

 

Instead of double – clicking, you can drag and drop any Direction or Spectrum to the 

show list. 

 

If you don’t want to display some items from the shown list, just double – click on that 

items and they will be removed from the list. 

 

Finally, press the Show button, and the entire list will be shown. 

 

After you have displayed some trends and spectra – set, the main window remains active 

and you can select other trends or spectrum. Although a large number of information can 

displayed on a single screen, it is recommended to limit the number of simultaneously 

opened plots, because the plots will have smaller and smaller sizes and many details will 

be lost. 

 

When one or more plots are displayed, you can use Window Menu to arrange the plots 

on the screen. You can clear the screen using Clear All command or you can copy on the 

Clipboard any plot using the Copy to clipboard command. 

 

 
 

For details regarding an efficient way of using the spectra and trends plot, see also: 

Spectrum plot and Trend plot. 

 

The advantage of using Selection view: 

 Any trend, spectrum or coast-down measurement can be displayed onto a 

single screen. 

 The number of displayed plots is limited only to the screen size. 

 

A disadvantage of using Selection view: 

 Long time to select the plots. 
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14.2 Trends and spectra for the whole machine 

 

With this command, you can see in a single “scrolling” screen all the trends and spectra 

associated with a machine. The last measurements will be displayed onto the spectrum 

plots. 

 
 

First, select from the hierarchy tree the desired machine. In the right part of the 

selection window, a list with all directions of the selected machine will appear. 

 

You can rearrange the list before showing, by dragging the items. 

 

Now you can remove some items from the list (by double-clicking on them) or show the 

list by pressing the Show button. The plots will be shown in trend-spectrum pairs. If you 

don’t need all the plots, close some of them and use the Arrange machine plots 

command from Windows menu, to rearrange the plots on the screen. 

 

If you move the cursor in a trend 

plot, the contents of the associated 

spectrum plot will also be changed, 

to reflect the actual position of the 

cursor. 

You can synchronize the cursor in 

the spectrum or trend plots. 

 

For more details, see also: Trend 

plot and Spectrum plot. 

 

Finally, use the Clear All command from Windows menu to close all plots. 

 

The advantage of using Machine plot view: 

 All trends and spectra associated with a machine can be displayed in a single screen. 

 

A disadvantage of using Machine plot view: 

 Only plots belonging to a single machine can be shown. 
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14.3 Quick View 

 

This command shows trends and spectra in a special way. When you select this 

command a four-window screen will appear: 

 

Database tree 

Trend plot 

Spectrum plot 

Notepad editor 

 

All four windows are synchronized. If you move the cursor in the database tree, all the 

other windows will be refreshed. If you change the position of the cursor in the trend 

plot, the spectrum plot and the notepad contents will be changed. That’s how you can 

immediately see all the information you need for the whole database. 

 

 
 

You can change the position of the windows on the screen, but you can’t close plot 

windows. If you close the tree window, all the windows will also be closed. The last 

position of the windows will be saved. 

 

Use Arrange Quick View command from the Windows menu to rearrange the window 

in a convenient way. 

 

The Notepad Window can be closed whenever you want. 

 

The advantage of using Quick View: 

Any trend or spectrum from any part of the database can be 

displayed. 

Quick access to any plot from the whole machine database. 

 

The disadvantage of using Quick View: 

Only a single pair trend-spectrum can be displayed at the 

same time. 
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14.4 Band View 

 

A band is a defined portion of a FFT spectrum. The bandwidth can be calculated with the 

following formula: 

 

 
The amplitude value of the band is calculated with the formula: 

 
where Li = Spectrum line inside of Bandwidth 

 

Each band has a specific frequency, generally a fault frequency or a multiple of it. 

In CXSpectra™, for each Direction, up to 32 narrow bands may be defined. 

 

 
 

 

14.4.1 Defining Bands 

 

The bands can be defined in the Database Edit menu, on each Direction level. 

Band definition can be made after all the fault frequencies and the alarms were defined 

for the selected Machine.  

To start an editing session, just press the Narrow Band button: 

The Narrow Band Setting window will appear: 
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The editing window contains a spreadsheet (or a table) where you can edit up to 32 

Bands. 

 

The table has the following columns:   

 

 
 

 Type – In this column you can select from a combo box one of the 

following types for the central frequency: 

 Defined – The Band central frequency won’t be calculated from the 

spectrum, just the defined frequency will be used to calculate the Band 

amplitude. 

 Calculated – The Band central frequency will be re-calculated in 

accordance with the real shaft speed from the Spectrum. The actual 

frequency is calculated around the Defined frequency with a gap of ± 2 × 

Spectrum Lines. If in this range a spectrum peak isn’t detected, the 

Defined frequency band will be used instead. If the Defined frequency is 

zero (normal setting for variable speed machines), the best shaft speed is 

considered to be the highest peak in spectrum. 

 Measured – The Band central line is calculated in relation with the 

measured speed, during data acquisition. If the speed wasn’t measured, 

the frequency of the band will be zero! Never define the Band with 

Measured type, if you are not sure that the speed will be measured 

together with the spectrum. 

 

Band name – This item must be added by the user, in order to identify the band later. 

Frequency – This is the central frequency of the band. The frequency must be selected 

from a list during the editing process. 29 possible fault frequencies are available in 

CXSpectra™. These frequencies must be previously defined. Only the defined frequency 

will appear in the list. In the following table, there are described the fault frequencies 

defined in CXSpectra™: 
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Frequency Description 

Primary reference 

speed 

Defined at Machine level, usually is the drive rotational speed (it 

always exists) 

Secondary 

reference speed 
Defined at Machine level, usually is the driven rotational speed 

Line frequency Defined at Machine level, this is the line frequency, 50 or 60 Hz. 

Pole pass 
Defined at Machine level, this is the Pole pass for asynchronous 

electrical motors. 

Rotor bar pass 
Defined at Machine level, this is the Rotor bar pass for 

asynchronous electrical machine 

Belt Defined at Machine level, this is Belt fault frequency 

Multiple frequency 
Defined at Machine level, this is any multiple frequency for the 

above. In CXSpectra™, up to 5 Multiple can be defined. 

Shaft Speed 
Defined at Point level, this is the shaft speed defined as a multiple 

of the primary or secondary reference speed (it always exists). 

BPFO, BPFI, BSF, 

FTF 

Defined at Point level, these are the bearing frequency faults. In 

CXSpectra™, for each Point, up to 4 bearings can be defined 

Gear box fault Defined at Point level, this is the gear mesh fault frequency. 

 

A special, 1 Hz fixed frequency can also be added as Band frequency definition. 

 

Value (Hz) – This column can’t be edited. In the column it was indicated as reference 

only, the actual frequency of the fault as it was defined previously. During showing data, 

this frequency is re-calculated according to the Type setting. 

 

Multiple –This is a multiple of the fault frequency selected in the Frequency column. 

Using the Multiple factor, many Bands can be defined, having the same fault frequency 

as reference. 

 

Gap (Hz) - This is the gap of the Band. The gap can be selected from a list and can be 

from 0 to 50 Hz. As a general rule, the gap can be at least the spectrum resolution. If the 

gap selected below is the spectrum resolution, the band will be the peak amplitude. 

If you select a zero value for the gap, the band will be the peak amplitude. Use a zero 

gap value, if you intend to have a trend for a peak instead to have a trend for a Band. In 

run-time, for each measurement in the Trend, the correct frequency will be calculated, 

but only if you select Calculated type Band. If you select Defined type Band, because 

the peak value can shift, the Trend results can be erratic. Using fixed frequency of 1 Hz 

and gap, you can define fixed Bands. To define a band for low frequencies from 0 to 6 

Hz, select as Frequency a Fixed (1 Hz) frequency, Multiple to be 1 and Gap also 5 Hz. The 

band will have a range from 0 to 6 Hz. 

 

Warning – This is the Warning level of alarm, defined in the unit and the average 

selected in the Alarm Settings. An automatic setting is also possible, if a Baseline 

spectrum is defined.  

 

Danger – This is the Danger level of alarm, defined in the unit and the average 

selected in the Alarm Settings. An automatic setting is also possible, if a Baseline 

spectrum is defined.  

 

Active – If active is set to YES, the band can be shown in “Quick View” or in “Band 

View”. If the setting is NO, the band is only defined, but it cannot be shown. 

 

In the Band definition window, a series of buttons are available in editing time: 
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 Delete – Use this action to delete the selected portion from the table. 

 Copy – Copy all table contents in the Clipboard. Later, you can Paste the table 

contents to another Direction in Tree. 

 Paste – If is enabled, you can Paste the table contents previously copied. 

 Copy to all – Copy the contents of the table definition and apply the contents to 

all Directions from the selected Point. 

 Alarm – Automatically applies a calculated level alarm for all the defined faults, 

based on Baseline spectrum. On the same Direction a Baseline must exist, 

otherwise the action fails. 

 

 

 Save – Save the definition in the Machine Database. Always, when you have 

changed an item in the table, before Exit, you must save your changes. An 

automatic saving is done after Delete and Paste actions. After Copy to all 

action, the band definitions from other Directions are also saved also. 

 

Editing items in the table is very simple: Move the cursor into the cell where you intend 

to change something. Just type directly the new value. If a combo box appears, use the 

up and down arrows to select the proper item and press Enter to complete. If the cell is 

a direct editing field, just type the numbers or letters.  

 

To complete, press the Enter key. You can also use the mouse, just clicking in the cell 

you intend to edit. Once you click the mouse into another cell, the previous cell editing 

mode ends. 
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14.4.2 Recommendation for Band definition 

 

A large number of bands can be added in the Database. Some of them can be useful, but 

some of them not. Follow the rules described here, to save your time and to add more 

functionality in your software. 

 

Add bands for Shaft Speed and also for 2 × Shaft Speed and 3 × Shaft Speed. The 

best Gap setting is the spectrum resolution, but not less than 1 Hz. Band Type must 

be set to Calculated. 

Add a band to Line frequency and to 2 × Line Frequency (if you have an 

asynchronous electrical motor). The best Gap resolution must be set as above. Band 

Type must be set to Defined. 

Add Belt fault, if the assembly has a belt. The best Gap setting is 2 × spectrum 

resolution. Band Type must be set to Calculated. 

Add Multiple for motor fan blade and also for pump blade. The best Gap is 2 × 

spectrum resolution. Band Type must be set to Calculated. 

Add bearing fault frequencies, if you have roll bearings. Band Type- Calculated. 

Add a fixed 0 to 5 Hz band frequency. Band type – Defined. 

 

Usually, the above mentioned bands are required during the diagnosis procedure. 

More bands can be added for special machines or for specific purposes. 

14.4.3 Showing Band in Quick View Mode 

 

The bands can be shown in Quick View or in Band View: 

 

In the Quick View, select a Direction and extend the tree. All 

defined bands will appear in the tree. 

The Trend Plot will be shown in the right side (for the selected 

band). 

The Spectrum Plot will be shown below. 

 

In the spectrum the selected band will be clearly marked. If the band 

has also an alarm defined, the band will be tri-colour, showing the 

Warning and Danger levels. 
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   NOTE: In the spectrum, the alarm levels are shown only in reference purpose. 

Remember that the alarm levels are for the Bands and not for the peak. Always, 

the Band alarm limits will be higher than peak height, because the band value is 

an average of all the band peaks. Only if the band contains a single peak, the 

alarm level will be valid also for peak. 

 

    

   NOTE: If the Gap value is zero, a single line will mark the Band. 

 

A Band report is available from the menu in the trend window and the spectrum report 

from the pop-up menu for the spectrum plot.  

14.4.4 Showing Band in Band View Mode 

 

Showing bands in Band View is very similar with showing bands in the Quick View mode. 

In the left tree only the Database hierarchy up to Point level appears. Once a Point is 

selected, in the right side appears a list showing Total values for all Directions and also 

the bands values. 

 

The items have coloured icons to indicate the band alarm status. Magenta colour denotes 

that the Warning and Danger limits are zero (no alarm set). 

 

 
 

In the List, a pop-up menu is available: 

 

 
 

Using this menu, you can display the whole spectrum or the band trend. 
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This feature is not the same as in Quick View.  Each plot required in the Pop-up menu 

above is displayed for the selected item from the table. The plots do not reflect the 

selection changes and must be closed manually.  

 

You may copy the relevant plots in the Notepad or in MS Word, Spectrum also to MS 

Excel. For MS Word and Excel there are buttons to be pressed. If you want to copy a 

plot to the Notepad, select trend plot, press CTRL+C, open the Notepad and press 

CTRL+V or select paste from the mouse right button pop-up menu. 

 

A Band Report is available to be shown in Print Preview or to be inserted in a MS Word 

document. 

If you intend to re-arrange the Band View window, just select from the CXSpectra™ 

main menu the Windows/Arrange Band View option. 

 

In the following simple database, 4 bands are defined for each Direction as follows: 

 

 
 

A narrow band for the Primary RPM (17.4 Hz ± 1 Hz) 

A narrow band for the Secondary RPM (24.71 Hz ± 1 Hz) 

A wide band alarm covering the range of 290 Hz ± 50 Hz 

A wide band alarm covering the range of 190 Hz ± 50 Hz. 

 

Alarm settings for the bands are automatically calculated from the Baseline. 
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Open Quick View and extend the tree up to bands level. Select any band you want to. 

In the right side, the trend plot will be changed to show the trend for the selected band. 

Also in the spectrum plot, the band will be marked. 

 

Notice that to display the normal Quick View style, just not extend the Direction item. 

Now, you can move the cursor in the trend and the spectrum plot will be refreshed. Any 

time you move the cursor, the peak found in the spectrum plot is slightly moved, but a 

peak is always correctly found. The wide bands cover a 200 Hz range, above the 

Secondary RPM frequency. 

 

Now you can return to Database Edit and add more band definitions for all the major 

faults detected. 
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14.4.5 Band Alarm in tree 

 

When you update the alarms in the Database (Command Update Alarm Status in 

Database menu), the following attention message will appear: 

 

 

Now you have two options: 

 To press NO and the bands alarm 

won’t be updated in the database tree 

 To press YES and the bands alarm 

won’t also be included in the database tree. 

 

 

If the database is large and many bands alarm are defined, the above action can take 

minutes. You also must consider the following aspects: 

 The alarm in tree (coloured icons) is a good indication for you that something 

wrong was happened with your machine. In fact, this is the first information 

regarding machines running conditions. 

 If you also add alarms, the band alarm and many band alarms are defined for the 

machine, the probability to obtain a “coloured” icon for the machine is very high. 

In most of the cases, the machines alarm will be in “red” status. 

 

Let’s have a look: 

 

 

In the machine tree, the MACHINE 1 is in Danger 

condition: 

Because the point P4 is in Danger alarm, also the MACHINE 

1 and DEPARTMENT 1 are in Danger alarm. If you expand 

the tree more, you can see that the problem isn’t the total 

value of the point P4, but the “Secondary” band, because the 

total value of the vibration in point P4 is below the Warning 

limit. 

 

 

   NOTE: Showing band alarm in tree can create confusion, so it’s always your 

decision if the band alarms will be added or not to the database alarm update.  
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14.5 List view 

 

Using List View, you can see the alarm status for all Machine Points in a single list, 

without the bands alarm included. 

List View never includes the bands alarm.  

 

 

 
 

 
 

 

In the List View the following items are displayed: 
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 Total vibration values 

 Total BE 

 Total Envelope values 

 Manual entry point 

 mV Measurements 

 

15 CXSpectra™ Reports 

 

The following pre-defined reports are included in the CXSpectra™ software: 

 

Job Report 

Total Value Report 

Machine history Report 

Machine description Report 

Excel Quick Report 

Transfer Report 

Unmeasured Machine Report 

Diagnosis Report 

Balancing Report. 

 

Most of them can be user customized by the user. 

 

Any report can be send to a text editor for more changes. 

15.1 Job Report 

 
The Job Report contains the last notes made by you for the selected machines. This 

report is dedicated to the maintenance team. 

 
 

The notes are a consequence of the diagnosis process, using the measurements unloaded 

from the data-collectors. 

 

First, select the machines from the hierarchy tree. Just double-click on each machine or 

drag and drop the machines in the selected machine list. You can remove some machines 

from this list, by double-clicking the mouse. Now, if you use the software for the first 

time, you must customize the header and the body of this report. 
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To edit the header press the Header button. A specific window will appear.  

 

In the pop-up menu (activated with a right-mouse click) you have some reserved words, 

all included in square brackets. These words will be replaced in the final report, in 

accordance with the actual contents of the database. In the Job Report Header you can 

add the following items: 

 

 

 

 

 

     [Date] – Current date 

     [Time] – Current time 

     [DBas] – Active Database name 

 

 

 

 

 

 

You can preview a sample of the header pressing the Preview button from the toolbar. 

 

The latest contents of the header will be automatically saved for a later usage. If you 

want to have more than one type of header, save the contents in a file! That’s how you 

can customize as many header types as you want. 

 

Next time, you can restore the contents of the header from the saved file. Pressing the 

Picture button from the toolbar, you can include a picture in your header (e.g. company 

logo). The Header Edit Window shows the header at 1:1 scale, depending on your 

printer settings. 

 

In a very similar manner you can customize the body. Press Body. 

 

In the pop-up menu (activated with a right-mouse click) you have some reserved words, 

all included in square brackets. These reserved words will be replaced in the final report, 

according to the actual contents of the database. In the Job Report Body you can add 

the following items: 

 

 

 [MPic] – Machine picture, defined in the Database Edit 

 [Note] – Contents of the last Notepad contents 

 [MPar] – Department name 

 [MNam] – Machine name 

 [MDes] – Machine short description 

 [Ndat]  -  Last Notepad entry date 

 [DBAs] – Active Database name 

 

 

 

 

 

Before printing, you can edit the contents of the notes. Use Notepad button, but first 

select the desired machine from the Selected machine list. 

Finally press the Print button and the Report Preview window will be activated. 

 

See Report Preview for more details. 
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15.2 Total Value Report 

 

The Total Value Report is similar with the Job Report, but also contains a table with 

the Total Value for every machine: 

 

 
 

First select the machines from the hierarchy tree. Just double-click on each machine or 

drag and drop the machines in the selected machine list. You can remove some machines 

from this list, by double-clicking the mouse. 

 

 
 

Now, if you use the software for the first time, you must customize the header and the 

body of this report. 

 

To edit the header press the Header button. 

 

Additionally, you can include in the report the machine picture and the user notes. 

 

Press Preview button to visualize the report contents. 
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15.3 Machine History Report 

 

The Machine History Report contains all the notes for a selected machine. 

 

First, select the desired machine, and decide if you want a report with the whole history 

or just a partial report. Now, if you use the software for the first time, you must 

customize the header and the body of this report. To edit the header press Header 

button! A specific window will appear. 

 

 
 

 

In the pop-up menu (activate with a right-mouse click) you have some reserved words, 

all included in square brackets. These words will be replaced in the final report, in 

accordance with the actual contents of the database. 

 

 

You can preview a sample of the header just pressing the Preview button from the 

toolbar. The latest contents of the header will be automatically saved for a later use. If 

you want to have more than one type of headers, save the contents into a file! That’s 

how you can customize how many header types you want. Next time, you can restore 

from the saved file the contents of the header. 

 

Pressing the Picture button from the toolbar, you can include a picture in your header 

(e.g. company logo). The Header Edit Window shows the header at a 1:1 scale, 

depending on your print setting. 

 

In a very similar manner, you can customize the body. Press Body. 

 

Finally, press Print button and the Report Preview window will be activated. 

 

See Report Preview for more details. 
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15.4 Machine Description 

 

The Machine Description Report contains in the body the description of the selected 

machine. 

 

 
 

First select the desired machine. 

 

Now, if you use the software for the first time, you must customize the header and the 

body of this report. To edit the header, just press the Header button. A specific window 

will appear. In the pop-up menu (activated with a right-mouse click) you have some 

reserved words, all included in square brackets. These words will be replaced in the final 

report, in accordance with the actual contents of the database. 

 

You can preview a sample of the header, by pressing the Print button from the toolbar. 

The last contents of the header will be automatically saved for later use. If you want to 

have more than one type of headers, save the contents of the header in a file! That’s 

how you can customize how many header types you want. Next time, you can restore 

from the saved file the contents of the header. 

 

Pressing the Picture button from the toolbar you can include a picture in your header 

(e.g. company logo). The Header Edit Window shows the header at a 1:1 scale, 

depending on your print settings. 

 

Finally, press the Print button and the Report Preview window will be activated. 
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15.5 Excel Report 

 

This report is available only when Quick View is active.  

 

First select the machines from the hierarchy tree. Just double-click on each machine or 

drag and drop the machines in the selected machine list. You can remove some machines 

from this list, by double-clicking the mouse. 

 

Press Create button and the report will be created into an Excel spreadsheet. 

 

 
 

Please note that Microsoft® Excel must be installed into your computer. 
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15.6 Transfer Report 

 

Transfer Report can show any route transfer in the CXSpectra™ database. 

 

From the list, select the transfer date.  

 

Press the Print button to show the report. 

 

The report can contain all measurements or a selection, depending on the Alarm 

conditions. The alarm limits are collected from the route settings. 

 

The specified number of the highest peaks from spectrum can also be shown. 
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15.7 Unmeasured machine Report 

 

This report can be useful to find the unmeasured machines since a specific date. 

 

Select the date first and press the Search button. The report will be displayed in the 

print preview window. 
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15.8 Diagnosis Report (Defect List Report) 

 

This paragraph describes how to use the Defect List Report to perform the diagnosis. 

 

In a machine diagnosis task, the major difficulty occurs because of the amount of 

information required for a precise diagnose. The computer size is limited, so not all the 

necessary spectrum plots can be simultaneously displayed in the same time. In the 

spectrum plot, the fault lines can be shown, but if they are many, these can’t be usable. 

 

The Baseline spectrum and the latest measurement are very 

useful for diagnosis also. The alarms limit set during the 

machine Edit also can provide valuable information. Using this 

new report, the user can access at once all the relevant 

information regarding machine condition. 

 

Diagnosis is a valuable tool to speed-up the diagnosis process. 

Diagnosis is available in the CXSpectra™ application 

beginning with SP8. 

 

The command is available in the Main menu, under Report 

menu: 

 

 

15.8.1 Using Machine Diagnosis 

 

When this command is selected, the window beneath will appear: 

 

 
 

The Constants window show the alarm level, for all the types of faults available in the 

CXSpectra© software. 
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The alarm levels are calculated using the alarm defined for Total Vibration values 

(Warning and Danger limits. 

 

In this release, the constant values can’t be adjusted by the user. 

 

The report has several tables for each Direction: 

 

Total value table 

Fault frequency table – latest measurement 

Fault frequency table – baseline  

Highest peak value in spectrum – latest measurement 

Highest peak value in spectrum – baseline 

 

If Baseline is not defined, the table with baseline information will not appear. It is highly 

recommended to define a baseline measurement for each Direction. This can be done in 

Edit command. 

  

15.8.1.1 Total value table 

 

 
 

In the table above, the latest two measurement values appear together with the baseline 

value. If the Envelope measurement is defined, also the Envelope magnitude will appear. 

If the alarm limits are exceeded, the values appear coloured in yellow or red. 

 

15.8.1.2 Fault frequency table – latest measurement 

 

In the table below, the values for all defined fault frequencies are displayed. 

 

 

 

Fault frequency can be defined in the Edit Window. The fault frequency can be 

defined on the Machine, the Point or the Direction level. The shaft speed, the fist 

two harmonics and the Low frequency are always shown. 

 

 

If the fault frequency represents a peak in the spectrum, the value is marked with a 

trusty flag. If the fault frequency is not a peak, but closed, the values are marked as not 

trusty. In this last case, the displayed value, in the majority of cases, DOESN’T represent 

a fault. 
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15.8.1.3 Fault frequency table – baseline 

 

This table is similar with the previous, but it refers to the baseline spectrum. 

A simple analysis of these tables can give a first impression regarding the faults 

evaluation. 

 

15.8.1.4 The highest peak value in spectrum – latest measurement 

 

 
 

In this table, only the first ten fault frequencies are shown, but the change in magnitude 

since the last measurement is also shown. 

 

If a peak is not identified, the Fault name is missing. If this happens for the majority of 

the highest magnitude lines, it seems that the fault frequencies are not completely 

defined for that Direction. Return to Edit menu and add all the available fault frequencies 

associated with the Machine. 

  

15.8.1.5 Highest peak values in spectrum – Baseline 

 

The table is similar to the table above, but it shows the highest magnitude peak for the 

baseline spectrum. 
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15.8.2 Best practice for a suitable Defect List Report 

 

The Report contains only the existing information from the database. Lack of information 

will give a poor Report: 

 

 
 

Follow the rules below, to produce a useful Report: 

 

Always define a baseline spectrum for each Direction 

Define as many fault frequencies as possible. 

Adjust the correct shaft speed in spectrum, before using this command. 

Measuring the speed during data acquisition is the best practice, at least for a 

single Direction. If this isn’t possible, adjust manually the correct shaft speed for 

a single Direction belonging to a Machine and use the Speed Tool menu to set 

the proper shaft speed to all Machine Directions. 

The magnitude values are important. Even low magnitude peaks can be relevant 

for the machine condition. 

Set the Total value alarms according with a well known standard. Be careful to 

set other smaller limits for Vertical and Axial directions. Don’t use the same limits 

for all measurement directions! 

Add your comments from the Notepad to the Report. They will be very helpful 

during the diagnosis process. 

From the information provided by this Report first try to find what faults the 

machine DOESN’T have, rather than trying to detect the existing possible fault. 

Eliminate, one by one, the inexistent faults and finally you will obtain a short list 

with all possible faults. Now it will be easier to determine the real faults!  
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15.9 Balancing Report 

 
 

 

 

This command can be used to create a Balancing Certificate, 

using the Balancing Files downloaded from CXBalancer® 

Instrument (.MV4 extension files). Balancing Files must exist in 

the machine Database. 

  

 

 

 

 

 

 
 

Report Header can be customized by pressing Header button. 

Pressing Body button, the user can customize the report as follows: 

 

Rotor picture - Adds also the rotor picture to the Report. 

Vibration - Includes also the initial and final vibration measured during the 

balancing session. 

Balancing Matrix - Includes the calculated Balancing Matrix in the Report. 

Measurement list - Includes all the Fine Balancing measurement. As default, 

only the latest fine balancing is included. 

Trial Run Results - Includes the trial run details in the Report. 

User Notes - Includes also the User Notes (if exist). 
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From the left List the user can select the Balancing Report to be printed. When the 

Print button is pressed, the Balancing Report is shown into a Preview Window. From 

here, the report can be printed. When a Balancing File exists in the machine database, in 

the CXSpectra© Notepad appears a new icon, in the upper-right corner.  

 

The report can be printed also from here: 

 

 
 

See below a part of the report: 
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15.10 Print Preview 

 

Before printing a Report, the contents are shown in a Print Preview window. Page 

selection is used to browse between the report pages.  

 

 
 

Using Zoom button you can adjust the report size on the screen.  

 

Press the Print button to print the report. 

 

Press Save button to save the report in a file.  

 

Press Word button to copy the report contents in a MS Word document (the MS Word 

must be installed on your computer). 
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16 Updating alarms 

16.1 Introduction  

 

When the machine tree is shown, the item icons are coloured according with the current 

alarms levels. 

 

This is true only, if the latest alarms were updated recently. 

 

The actual Alarm Status can be seen looking at the Manual Alarm Update button from 

the Main Menu toolbar: 

 

 
 

If the button is pressed (the middle picture) the alarms are correctly shown and no 

update is required. 

 

If the button isn’t pressed (the right picture), the alarms need to be manually refreshed. 

To do this, just press the Manual Alarm Update button. 

 

Because the machine databases can be accessed at the same time from many computers 

across a network, in a network environment only, might be possible that the user hasn’t 

been informed about the real status of alarm in the database tree. 

 

See the schematic below. This is a typical accessing diagram for the machine database in 

a network: 

 

 
Any of the users above can make some changes in the machine database adding new 

measurements. There is further described how the user can set the CXSpectra™ in a 

way to be always informed in time about any change in the alarm status and also how 

the alarms update might be done. 
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16.2 Settings alarm of CXSpectra™ application 

 

In order to receive periodical information regarding alarm update status, the user has to 

set some options in the Setting > Optional settings window. 

 

 NOTE: The alarms are not automatically updated, but just the database is 

checked for new measurements. 

 

If new measurements exist in the database, the Manual Update Alarm button will be 

changed to not pressed, as it follows: 

 

 
 

If the mouse cursor is moved in the button area, the tool tip text will indicate, if the 

alarm update is required or not. 

 

If the alarm update is required, a manual update is necessary. Just press the button and 

the update procedure will begin. 

 

 NOTE: For medium and large machine databases, a complete updating 

procedure can take minutes. During the alarm update, the software is locked for 

the user. That’s why a full automatic procedure can’t be implemented. 

 

16.3 Semiautomatic alarm update 

If, for instance, in CXSpectra™ a measurement download occurs, the user can decide, if 

also the alarm update must occur, when the transferring measurement is over. 

 

 

In any transfer 

window a check box 

is placed into the 

window lower side. 

 

The Manual Entry 

transfer window is 

shown in the left 

side picture: 
 

Update alarm box 

is checked as 

default.  

 

When the Exit 

button is pressed, 

an automatic alarm 

update will also 

occur. 
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 NOTE: If any user in the network performs an alarm update procedure, all the 

other users will be informed about this. The Manual Update Alarm button will 

change the status to un-pressed. 

 

 

17 Exchange machines 

 

Sometimes, you will need to move or copy a machine from one database to another. 

CXSpectra™ offers the possibility to move or copy machines between any two 

databases. 

 

Select Database > Machine exchange command. 

 

 
 

 

1. Source database 

2. Move button 

3. Destination database 

4. Select Department (Plant)  

5,6,7 Select transfer options 

8. Save (move) the added machines 

9. Exit button 

10. Cancel button 

 

Both databases must be registered. 
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Proceed as follows: 

 

Select the source database from any registered databases(1). 

Select destination(3). The destination database must have at least one Department 

(or Plant). You can’t copy a machine in an empty database. If you intend to move 

the whole source database in a new destination database, first use Edit command 

and create the same Departments as in the source database. 

First select the Department(4), where you intend to copy a machine. 

Select the machine. The MOVE button (2) will be activated. Press the button and the 

machine name will be moved to the destination. The contents will not be transferred, 

yet. After transferring one machine, the item in the source tree will advance to the 

next machine. Press the MOVE button again, until all the machines are “moved” into 

the desired destination.  

Select the copy options (5,6,7): you can copy only the machine definition or the 

measurements. 

Finally, press the SAVE (8) button. All the selected machines will be copied to the 

destination. This action can take a few minutes. 

 

Using the Exchange Machine command, you can create a single database using the 

machine stored in several databases. This action can be helpful to move your databases 

into another computer. 

18 CXSpectra™ translation 

 

CXSpectra™ is multi-lingual software. The entire program message is stored in 

MessageCX.mdb file, a Microsoft Access database. In order to have a CXSpectra™ 

version in a specific language, the entire database must be translated. 

 

 
 

Just select Settings > Translate command. 

First select any empty text box and fill it with your language name. 
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In the table, complete the item 1 with your language name (can be typed in your local 

language). 

 

Now, begin the translation. Be careful, in English all the messages are shorter than in 

most of the other languages! If you don’t understand completely how to translate some 

sentences, just skip the row. You can do this later. 

 

When you finish, close the translation window. Your work will be saved in the 

MessageCX.mdb file. If you update CXSpectra™ with a new Service Pack, don’t worry! 

The Service Pack won’t delete your translation file, but will just add the newest words 

or sentences (in English). Just run again the Translation software and translate the latest 

messages. 

 

Your language will appear in the translation list. Just select your language from the list 

and next time, when you will start CXSpectra™ messages will be in your language. 

 

The latest saved language is saved in CXSpectra™, as shown above. 

If some messages aren’t translated, you have the possibility to make the translation 

when you run the CXSpectra™. 

 

To do this, proceed as follows: 

 Locate CXSpectra on your computer (in a default installation the file will be in 

C:\CXSpectra). 

 Just double-click the file to be opened in Notepad. 

 

The first part of this file is shown below: 

 

[General] 

Language=1 

MessagePro=C:\CXSpectra\MessageCX.mdb 

TranslateMode=0 

; TranslateMode=0 Un-translated message will be shown in 

English 

; TranslateMode=1 Un-translated message will be shown as 

#NoMessage = Message in English 

; TranslateMode=2 Un-translated message can be edited on fly 

 

Change TranslateMode to 2 and save the file. 

 

Always, when you will run CXSpectra™ again and un-translated messages will be found 

in the translation file, an edit window will be shown: 

 

 
 

Now you have the possibility to translate on-fly the message. 
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Don’t use this setting when there are too many un-translated words! 

The running of CXSpectra™ will be interrupted often and you will be unable to 

use the software. Don’t forget to set back the TranslateMode in the 

CXSpectra.ini file. 

 

19 Route inspection code 

 

In the Settings > Route inspection code menu you can activate the window below: 

 

 
 

In this table you can add up to 64 inspection codes. 

 

When a measurement is done, you will always have the possibility to select one or more 

Inspection Codes from a popup list, in the Instrument. 

 

When the measurements will be downloaded in the machine database, in the Notepad 

also the contents of the inspection code will be added. 
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20 Using Notepad 

 

   Notepad is always available when a plot is visible on the screen. 

 
 

The Notepad can be activated from the main toolbar menu:                     

 

The Notepad can also be activated from the pop-up menus of each plot (Show notepad 

command line). 

 

The Notepad date appears in accordance to the plot date. From a trend plot, the 

Notepad will appear with the cursor date. 

Because the Notepad contents appear in many Reports, a proper documentation done in 

the Notepad will ensure a good report also.  

 
1. Menu bar 

2. Toolbar 

3. Insert picture 

4. Show all notes button 

5. Notepad date and time 

6. Edit area 

 

The Notepad must be used to document your diagnosis process. 

 

In the Notepad can be added: 

 Any plot from the screen 

 Any text using copy and paste 

 Any text or rtf. external file 

 Any picture (including digital camera picture). 

 Any link to a file (pdf, image files, document files, etc). The source link must remain in 

the same location (to be opened later). 

 



MaintTech Sweden   

 

129 
 

In the following example two links has been added in the Notepad: 

 First link to a PDF files 

 Second link to an image. 

 

 
 

When you right-click onto link, in the popup menu a new item will appear (depending on 

file added). 

 

 

You may open the file directly (or edit it): 

 

Popup for the second link (image file): 

 

 

 

 

 

 

The text can be formatted as in any standard text editor. The contents of a page can be 

saved in an .rtf file type. 

 

Notepad is page and machine oriented. Each page has its own date. The Notepad is 

synchronized also with the plots. When a plot sets focus and the Notepad is visible, the 

Notepad page will be automatically changed to the plot date and to the machine. If only 

the point or direction of the same machine is changed in the plot, the Notepad contents 

won’t be affected. This means that the Notepad always has the active page for the right 

date and for the active machine. 

 

You don’t need to save explicit the Notepad contents. When the page will be 

changed, the current contents are always automatically saved in the database. 
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21 GraphView 

 

If the machine database is accessible in a network, it is possible to present data in a 

simple, graphical way. 

 

A “black” protection key is required for each workstation. 

To create a GraphView data presentation follow the steps: 

1. Run Database > GraphView Editor. 

2. The following window will appear: 

 

 
 
3. Check one by one the Departments to be moved into the graphic area. 

4. Move the icons in the convenient location by mouse. 

5. Right-click the Department icon and a pop-up menu will be shown: 

 

 
 

From the above menu you can: 

   Rename the Department 

   Adjust the icon size (small, medium or large) 

   Select a background colour for the icon. 

6. Right-click in the graphic area. The following pop-up menu will be shown: 
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From the above menu you can: 

 Show-hide the grid in the graphic area 

 Add a background picture 

 Show hide lines for tags and change the lines colour. 

 

 

7. You can do the following actions: 

Add a temporary grid to the graphic area. 

Select a background picture. The picture must have an approximate size 

to cover all the display area. Any type of picture file is accepted. 

Add some position lines to the icons. 

Preview the final graphic aspect of the page. 

8. Double-click on each Department icon. In the left side of the window, the 

machine list will be shown. Proceed as before and add a machine. For each 

Department a new graphic page will be created. 

9. On each new page, double-click on each machine. In the left side of the 

window the Point list will be shown. Add the points (Directions will be added also) 

for each machine. For each machine a new graphic page will be created. 

10. In each page you can add a background picture. 

11. When you finish, just exit the GraphView Editor. The pages will be 

automatically saved in the machine database. 

 

Now, any computer in the network can be configured to show a graphic format of the 

database.  

 

To do this, proceed as follows: 

1. Install CXSpectra™ on the computer (and the latest Service Pack). Use a 

normal protection key to start CXSpectra™. Select the desired database and 

close CXSpectra™. Remove the normal HASP protection key. 

2. Insert in any available USB hub, a “black” protection key. 

3. When the CXSpectra™ starts, instead to open the normal window, it will 

show a graphical view of the database. 

 

In GraphView mode, the user can’t change anything; the database is read-only. 

 

If alarm limits are set, also the icons will be coloured according with the alarm levels in 

the machine tree. 

 

By clicking a Department icon, the Machine page will be shown. 

 

By clicking a Machine icon, a Point page will be shown. 

 

By clicking a Point icon, a special kind of QuickView will be shown. 

 

 

 

For testing purpose you may open the GraphView from the View 

menu: 
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This is what the user can see in GraphView mode: 

 

 

 

 

 

 

 

 

 

   On Department level 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    On Machine level 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

   On Point level 
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The number of workstations you can show the machine database in GraphView is 

unlimited. 

 

Contact MaintTech to obtain GraphView Protection Key. 
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22 USB Drivers 

 

No driver is required to connect the CXBalancer® Instrument to the computer. 

 

When you insert the connection cable in any USB hub, the Windows Operating System 

will recognize the Instrument microSD Card as a standard mass storage device and it will 

publish this. For the first time, this may take 20÷30 seconds. Then, the connection will 

be established in 2÷3 seconds. 

 

The single condition to establish the connection is: 

 

When you connect the USB cable to the PC and to the Instrument, the 

Instrument must be started and the user must select the Communication menu. 

 

The whole contents of the card can be viewed in the Windows Explorer, as any ordinary 

Removable Device. In the PC, you can copy, delete or remove files. You can also directly 

format the microSD Card, when the  CXBalancer® is connected to the PC. 

 

This is what appear when browse to the  CXBalancer® memory card: 

 

 
 

In above example, the CXBalancer® is recognized to be F:\ removable unit. 

 

Each folder is storing specific files. 

You may copy, delete or open the files. 

Also you may format the Memory card, but the stored data will be lost. 

 

In the example below, the contents of spectra files are shown: 
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NOTE: The card accepts in the Instrument only short name files. If long name files are 

added, into CXBalancer®, these files will appear truncated. 

 

23 Spectrum peak calculation 

23.1 Introduction 

When a peak in the spectrum plot is between the spectrum lines, the value of peak 

amplitude and its frequency must be calculated between lines. 

In this addendum the calculation algorithm is described. 

23.2 Peak calculation between spectrum lines 

Considering the spectrum line to be: 

Line(0), Line(1),….. Line(i),…….Line(n). 

Between two consecutive lines is a frequency gap equal with the spectrum resolution. 

A peak exists, if the following condition is true: 

 

1)Line(iLine(i)1)-Line(i    [1] 

Considering that, the Ampl is the peak amplitude 

and Freq is the peak frequency. 

There are three cases, when formula [1] is used: 

 

CASE 1: 

1)Line(i  1)-Line(i  

If the above condition exists when: 

 

)1)Line(i Line(i) 1)-(Line(iAmpl 222
 

 

Resolution  iFreq  

 

This is a particular case, in practice this condition 

never exists. 
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CASE 2: 

 

1)Line(i  1)-Line(i    [2] 

 

If the condition besides exists, when the peak is 

located between Line(i) and Line(i+1). 

 

The frequency gap (distance between the Line(i) 

frequency and the peak frequency) can be 

calculated with the formula: 

1)  (iTempValori

(i)TempValori
 1

 
1)  (iTempValori

(i)TempValori
- 2

deltaF  

 

 DeltaF is normalized frequency (for 1 Hz spectrum resolution). 

   After calculation the DeltaF value will be negative, in range (0 ….. -0.5). 

  

CASE 3: 

 

 

1)Line(i  1)-Line(i    [2] 

 

If the condition above exists, the peak is located 

between Line(i-1) and Line(i). 

The frequency gap (distance between the Line(i) 

frequency and the peak frequency) can be 

calculated with the formula: 

 

1) - (iTempValori

 (i)TempValori
1

2
1) - (iTempValori

(i)TempValori

  deltaF

 

 

 

 

 

After calculation the DeltaF value will be positive, in range (0 ….. +0.5). 

The calculated peak frequency in both CASE 2 and CASE 3 can be calculated as it follows: 

 

dF)  (i * Resolution  Freq   [3] 

 

The calculated peak amplitude in both CASE 2 and 3 can be calculated with the formula: 

 

 1)Line(iLine(i) 1)-Line(i  Ampl 222
 

 

The result is presented in the picture above: 
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24 Virtual instrument 

Just for training, you may use the CXSpectra™ software, even if you don’t have a 

CXBalancer® instrument, or if you want to see the screen of your CXBalancer® 

instrument onto the projection screen of video-projector. 

24.1 How to do a virtual CXBalancer®  

Use an empty and ordinary USB Memory stick. 

Copy the contents of CXBalancer® memory card into your stick root.  

You must also copy the CXBalSym.exe file. 

 

 
  

Into Windows File Browser name the memory stick as CXBalancer. 

 

 
 

You just got a virtual CXBalancer®. 

 

You can transfer a route from CxSpectra™.  

CXSpectra™ will consider your stick is a CXBalancer® instrument. 

 

Now, you can “collect data” into the route.  

 

Start your CXBalSym.exe application directly from the stick: 
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Use the "virtual" instrument, exactly the same you are doing with CXBalancer®. 

 

NOTE: 

You won’t be able to use the mouse, but only the keypad.  

To make the equivalence between the buttons of CXBalancer®  and those of the virtual 

instrument, just read the user manual of CXBalSym application.. 

 

Press the 8 key to see the route screen: 
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Press the F1 key to select the new route: 

 

 
 

Now, you can simulate you are collecting vibration measurements in the virtual route and 

then you download them back to the CXSpectra™ application. 

 

Following the same procedure, you can make spectrum measurements, Envelope or 

Frequency response. Then you have the possibility to download them all in the 

CXSpectra™ software. 
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Documentation Feedback 
 

Any suggestions and comments for improving this Application Notes should be e-mailed 

at mainttech@live.se 

MaintTech Sweden uses feedback for continuous improvement of our documentation and 

for future MaintTech products. We request comments be specific and include the product 

name and version. We cannot provide personal responses to every message received, 

but please be assured that all feedback will be given careful consideration for future 

improvements to the MaintTech documentation or software. 

 
Technical Support 

 

 

 

 

Contact Details 

 

For any problem regarding this application, feel free to contact our support team at: 

mainttech@live.se 

To know more about us, visit the following website:  http://www.mainttech.se/ 
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